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Abstract  

	 The	first	true	primates	in	the	fossil	record	are	known	from	near	the	Paleocene-Eocene	boundary,	

approximately	55	million	years	ago.	The	prevailing	evidence	suggests	that	these	primates	diversified	

rapidly,	making	the	sequence	of	events	which	make	up	their	evolutionary	history	challenging	to	navigate.	

(Kay	et	al.,	2004;	Rose,	2006).		A	powerful	tool	for	enhancing	the	understanding	of	primate	origin	is	

deciphering	early	primate	chewing	anatomy,	as	it	can	help	paleontologists	to	infer	a	range	of	features	

including	diet,	body	form	and	function	and	evolution.	(Perry,	2008).	The	study	of	such	ancient	anatomy	

is	inherently	difficult,	however,	due	to	their	fossil	remains	often	being	damaged	and	distorted,	having	

undergone	eons	of	geological	stress.	Furthermore,	soft	tissue	is	usually	completely	absent	from	the	fossil	

remains	of	this	time	period.	

	 Perry	and	colleagues	(2015;	2018),	however,	have	developed	a	rigorous	muscular	reconstructive	

techniques	using	mathematical	estimates	of	muscle	size	based	on	muscle-bone	correlation	in	living

analogs.		These	techniques	can	radically	enhance	the	reconstruction	of	a	specimen	but	can	be	hindered	

by	sediment	obscuring	the	necessary	osteological	measurement	points.		Additionally,	these	estimates,	

although	novel,	are	entirely	static	numerical	reconstructions	making	their	implications	and	plausibility	

difficult	to	visualize.

	 This	project	used	virtual	visualization	techniques	to	facilitate	both	the	accessibility	and	dynamic	

reconstruction	of	chewing	muscle	data	acquired	from	a	specimen	of	one	of	the	earliest	primate	species,	

Smilodectes gracils.		The	rigorous	restoration	of	the	virtual	skull	allowed	for	novel	jaw	adductor	volume	

data	to	be	collected	and	subsequently	visualized	through	an	interactive	web	application,	featuring	the	

virtually	reconstructed	3D	skull,	chewing	musculature,	and	an	animated	chewing	simulation	which	

brings	static	numerical	data	to	life.	This	project	contributes	to	the	fields	of	virtual	paleontology	and	

biocommunication	by	using	visualization	to	both	extract	and	dynamically	display	hard	data.	These	tools	

helps	demystify	a	portion	the	often	convoluted	and	controversial	discussion	of	primate	origins,	and	have	

implications	for	understanding	the	ecological	history	of	our	own	species	.
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IntroductIon

	 The	study	of	primates	has	always	had	inherent	interest	and	has	been	of	special	interest	since	Linneaus	

included	humans	in	his	classification	of	animals	(Linneaus	1735).		The	human	species	has	since	been	

traced	back	7.2	million	years	when	the	first	hominin	remains	occurred	(Burnet	et	al.,	2002).	The	first	

primates,	tiny	lemur-like	mammals,	however, occurred	almost	50	million	years	earlier.	The	study	of	

these	very	early	primates	enriches	our	understanding	of	living	primates	and	provides	a	more	complete	

understanding	of	the	primate	evolutionary	tree	to	which	the	human	species	belongs.	

	 This	project	offers	the	unique	opportunity	of	investigating	one	of	the	most	ancient	primate	species,	

Smilodectes gracilis,	by	exploring	a	remarkably	preserved	fossilized	skull	and	associated	jaw	discovered	

in Wyoming	in	1993.		Such	well-	preserved	and	near	complete	fossils	are	important	to	paleobiology	

because	they permit	a	richer	reconstruction	of	past	ecological	relationships	than	is true	for	most	fossils.		

This	project	utilized	the	CT	scan	of	the	specimen	(DMNH	10000,	housed	at	the	Denver	Museum	of	

Nature	and	Science)	to	study	the	chewing architecture and	dynamics	of	early	primates	by	virtually	

reconstructing a Smilodeces gracilis	cranium,	mandible	and	jaw	adductor	musculature	and	subsequently	

simulating	its	chewing	movement.		

1. Early Primates

	 The	first	true	primates	in	the	fossil	record	are	known	from	roughly	the	Paleocene-Eocene	thermal	

maximum,	approximately	55	million	years	ago.	Increased	temperatures	caused	a	cosmopolitan	dispersal	

that	included	a	thriving	group	of	early	primates	(Rose,	2006,	p.	343).	These	small	creatures	featured	

specific	arboreal	adaptations	that	set	them	apart	from	other	tree	dwellers	including:	a	specialized	grasping	

foot,	a	replacement	of	claws	by	nails	on	all	digits,	hind	limb	locomotor	dominance,	reduced	olfaction,	

stereoscopic	vision,	and	large	brain	to	body	size	ratios	(Cartmil,	1972;	Sussman,	1978; Rasmussen,	2007)

	 These	first	euprimates	(true	primates)	divided	abruptly	into	two	groups	that	are	thought	by	some	to	

represent	today’s	basic	dichotomy	of	all	primates.		The	tarsier-like	Omomyiforms	which	belong	to	the	

Haplorrhini	(	which	includes	modern	tarsiers	and	simians),	and	the	lemur	like	Adapiformes	which	belong	

to	the	Strepsirrhini	(which	include	modern	Lemuriformes.)	(Kay	et	al.,2004;	Rose,	2006).	Currently there	

are	no	transitional	forms	that	indicate	a	common	ancestor	between	the	Adapiformes	and	Omomyiformes,	

although	several	early	primates	from	India	are	so	primitive	that	they	are	difficult	to	allocate	to	either	
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group	(Dunn	et	al.,	2016).	The	prevailing	evidence	suggests	that the	earliest	primates	diversified	rapidly	

and	this	makes	the	members	of	the	two	groups	equally	important	in	enriching	the	understanding	of	the	

origins	of	all	primates.	(Kay	et	al.,	2004;	Rose,	2006).	(fig 1).  

	 The	Adapiformes	group	includes	the	most	primitive	and	well	known	of	all	fossil	primates	the	

Notharctids	(see	Gregory’s	1920	Notharctus	skeleton	study).	Some	of	the	most	common	species	found	

in the	early	and	middle	Eocene	deposits	are	of	this	group	and	thus	their	evolutionary	history	has	been	

comparatively	well	documented	and	has	even	been	used	to	support	evolutionary	gradualism	(Rose	2006).	

This	group	contains	six	genera	including	Smilodectes.	

 Smilodectes	is	composed	of	three	named	species	with	Smilodectes gracilis	being	the	most	well	

documented.	S. gracilis	was	a	successful	species	from	the	middle	Eocene	Bridger	Formation	of	Wyoming.	

Based	on	its	dental	morphology	it	is	thought	to	have	been	a	foliovore.	They	have	the	dental	formula	

2-1-4-3	and	lacked	a	fused	symphysis.		This	species	has	a	more	rounded	frontal	bone	and	shorter	snouts	

compared	to	other	Notharctids.	S. gracilis	also	features	comparatively	reduced	olfactory	bulbs,	an	

enlarged	visual	cortex,	and	relatively	smaller	eyes	than	their	nocturnal	counterparts,	all	of	which	supports	

the	inference	that	it	was	a	diurnal	species.	Its	cranial	capacity	of	9.5	cubic	centimeters	and	lower	average	

body	mass	of	2kg,	yields	an	encephalizaiton	quotient	relatively	high	for	the	Eocene	although	lower	than	

any	living	primate	(Gingerich,	1980)	.	From	studies	of	its	skeleton	it	is	thought	to	have	been	a	vertical	

climber	and	leaper.(Fleagle	1988).	

	 Although	the	Notharctids	features	some	fairly	well	described	genera,	including	Smilodectes,	there	are	

still	many	questions	left	unanswered.	A	shallow	knowledge	of	Notharctids	behavior,	diet,	morphology,	

body	form	and	function	and	evolutionary	history	warrants	further	study.	A	logical	place	to	start	is	a	study	

of	the	craniomandibular	anatomy	in	that	it	can	provide	unique	insight	into	each	of	these	areas	and	can	

especially	shed	light	on	feeding	behavior	and	diet.	Dietary	and	oral	processing	of	this	group,	in	turn,	can	

have	the	potential	to	illuminate	the	uncertain	euprimate	history	of	origin	given	that	most	reconstructions	

of	extinct	primates	include	some	inferences	about	diet.	(Cartmill,	1972	Sussman,	1991)

(Perry	et	al.,	2015)”)
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2. Chewing Anatomy and Biomechanics 

	 Feeding	behavior	allows	an	organism	to	acquire	the	energy	needed	for	sustaining	survival	and	the	

ability	to	reproduce.		Masticatory	anatomy	in	primates	should	therefore	be	selected	to	improve	their	

feeding	performance.	Ross	and	Diaz	suggest,	“Relationships	among	feeding	system	morphology, feeding	

behavior,	and	diet	not	only	explain	the	morphological	diversity	of	extant	primates,	but	can	also	be	used	to	

reconstruct	feeding	behavior	and	diet	in	fossil	taxa.	(Ross	and	Diaz,	2014	p	104)”.

2.1 Chewing musculature   

	 The	study	of	masticatory	anatomy	including	jaw	adductors	allow	for	important	inferences	to	be	made	

about	diet,	body	form	and	function,	and	evolution	(Perry,	2008)		This	is	because,	“Diet	and	mastication	are	

closely	tied	to	hard	anatomy”	(Perry,	2008).	Thus,	access	to	data	from living	analogs	make	reconstructions	

of	mastication	especially	justifiable	for	early	primates	(Perry,	2008)

	 Using	mathematical	estimates	of	muscle	size	based	on	muscle-bone	correlation	in living	analogs,	

Perry	and	colleagues	(e.g.,	Perry,	2008;	Perry	et	al.,	2015;	Perry	,	2018)	have	developed	one	of	the	most

rigorous	approaches	to	chewing	muscle	reconstruction.	For the	first	time	the	dimensions	of	the	chewing	

muscles	have	been	estimated	in	early	primates	using	correlations	between	muscle	dimensions	and	bone	

dimensions.	Although	many	suggestions	had	been	presented	on	early	primate	diet	(e.g.,	Covert,	1986;	

Ravosa,	1996),	no	study	had	produced	any	real	dimensional	data	on	chewing	musculature.	

	 Perry	et	al.	(2015)		utilized	living	strepsirrhines	as	analogs	for	early	primates.		A	sample	of	extant	

strepsirrhine	cadavers	was	used	to	“compare	the	osteological	proxies	of	muscle	dimensions	to	the	actual	

dimensions	of	the	muscle	they	represent	(Perry	2011)”.	These	same	proxies	were	then	made	on	adapid	

specimens	to	make	estimates	for	jaw	adductor	muscle	mass,	physiological	cross-sectional	area,	fiber	

length,	muscle	leverage,	bite	force	and	gape.	These	estimates	were	able	to	provide	another	source	of	

dietary	inference	in	adapids	and	was	able	to	strengthen	the	previous	dental-dietary	hypothesis	that	they	

were	foliovores	and	cast	uncertainty	on	the	hypothesis	that	they	were	gougers	of	tree	exudates.	

	 This	study	(Perry		et.	al.,	2015)	selected	Adapidae	as	subject	of	analysis	due	to	the	quality	of	the	

skull	specimens	because	feeding	behavior	inferences	on this	group	have	the	potential	to	illuminate	

euprimate	origins.	The	nothartids,	which	existed	simultaneously,	would	have	equal	potential	to	shed	light	

on	euprimate	origins.	Using	the	jaw	adductor	muscle	estimate	techniques	on	this	similar	group	would	be	

beneficial	providing	a	more	complete	picture	of	euprimate	phylogeny	and	origins	as	well	as	validate	or	

invalidate	the	current	dentition	based	hypotheses	about	Notharctid	diet	and	feeding	behavior.	S. gracilis 
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would	be	a	particularly	apt	species	to	utilize	these	techniques,	in	that	a	remarkably	well	preserved	

specimen	with	an	associated	jaw	is	available	(fig 2),	along	with	a	complete	micro	CT	scan	of	the	fossil.

	 Applying	these	muscle	reconstruction	techniques	to	the	S. gracilis	specimen	would	dramatically	

increase	the	value	of	its	reconstruction.		Even	these	advanced	reconstruction	techniques,	however,	have	

their	limitations.	Fossils	themselves	can	be	difficult	to	measure	due	to	their	distorted	state	and	sediment	

blocking	the	view	of	an	osteological	site	of	interest. The	act	of	handling	the	fossil	can	also	damage	it.	

Numerical	reconstructions	also	lack	visual	verification	of	their	feasibility.	A	volume	of	a	muscle	for	

instance,	may	seem	reasonable	until	it	is	recreated	physically	and	applied	to	the	bony	anatomy,	where	

flawed	proportions	can	suddenly	become	very	obvious.	Numerical	muscular	reconstruction	estimates	

also	cannot	demonstrate	how	the	muscles	interacted	with	the	skull	and	one	another,	or	how	they	behaved	

during	jaw	movement.		A virtual	3D	model	of	the	musculature	based	on	real	volumetric	data	would	have	

clear	potential	in resolving	some	of	these	issues.

Figure	2.	 Smilodectes gracilis fossil specimen of cranium and mandible (DMNH 10000).
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2.2 Chewing Biomechanics: 

	 Ross	and	Diaz’s	review	of	primate	feeding	biomechanics	suggests	that	biomechanics	“develops	and	

tests	hypotheses	relating	morphological	to	behavioral	variation	and	using	physical	principles	…	applied	

through	mathematical	models	of	biological	system.”	(2014,	p	105)	This	process	is	difficult	in	the	field	

of	extinct	primate	biology	in	that	the	behavior	of	extinct	primates	cannot	be	observed	and	thus	any	

mathematical	models	must	be	based	entirely	on	morphology.	

	 Furthermore,	historically	the	field	of	primate	jaw	morphology	and	biomechanics	have	been	

dominated	by	mathematical	modeling,	experimental	investigations,	and	anatomical	descriptions.	Most	

of	these	are	complicated	and	difficult	to	follow	for	the	uninitiated	student	or	beginning	researcher.	The	

development	of	powerful	digital	tools	for	visualizing	and	communicating	biomechanical	and	anatomical	

data	have	become	not	only	helpful,	but	perhaps	pedagogically	necessary,	for	educating	students	on	the	

complexities	of	masticatory	biomechanics.	In	this	project,	I	have	combined	data	from	strepsirrhine	

osteological	correlates,	the	anatomy	of	the	skull	in	Smilodectes gracilis,	and	3D	digital	tools	to	generate	

a	soft-tissue,	moving	model	of	chewing	in	this	early	fossil	primate.	This	model,	to	the	extent	possible,	

is	also	informed	by	experimental	data	on	chewing	movements	in	mammals	in	an	effort	to	bring	these	

experimental	studies	to	life.

3. Virtual Paleontology

	 Within	the	last	decade,	the	field	of	paleontology	has	experienced	a	“CT	revolution”	(Sutton,	2014	

p.6)	which	coincides	with	the	increased	availability	of	Computed	Tomography	scanning.		In	a	field	

devoted	to	the	study	of	delicate	three	dimensional	specimens,	the	advantages	of	CT	and	other	non	

destructive	scanning	technology,	are	obvious.	Studying	fossils	requires	extracting	information	from	

delicate,	3D	structures.	Traditional	methods	of	preparing	fossils	for	study	all	require	physical	handling	

and	processing	which	risk	damage	and	lost	data.	CT	scanning	allows	for	the	Paleontologist	to	analyze,	

isolate,	segment	and	immortalize	fossils	without	ever	touching	them.	Despite	its	advantages,	the	

techniques	involved	in	virtual	paleontology	are	not	as	widely	used	as	they	might	be,	in	part,	because	

they	are	considered,	“too	difficult”	(Sutton	2014)	and	time	consuming.	Although	digital	processing	a	

fossil	is	generally	faster,	a	good	quality	virtual	fossil	of	a	complicated	specimen	can	still	take	days	to	

prepare	(Abel	et	al.,	2012).	Creating	models	and	animations	which	clearly	display	a	novel	fossil	finding,	

can	take	even	longer.

	 Before	the	rise	in	CT	scanning	technology	and	virtual	paleontology,	paleontologists	heavily	relied	
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on,	and	still	rely	on	fossil	“preparators”	in	order	to	make	a	fossil	ready	to	study	(Brown,	2009).	

The	occupation	of	a	preparator,	involves	the	preparation	and	conservation	of	fossils	for	the	purposes	of	

research	by	scientists.	(Brown	et	al.,	2009)	In	a	text	book	describing	paleontological	techniques,	the	author	

writes,	“vertebrate	paleontology...is	a	field	of	study	where	the	accuracy	of	collection	and	preparation	of	

specimens	and	data	is	the	foundation	that	determines	the	ultimate	quality	of	the	science”	(Leiggi	and	

May,	1994,	vxiii).	This	notion	has	not	changed	with	the	shift	from	physical	to	digital	studies,	however,	

the	needs	of	a	virtual	paleontologist	have	shifted	to	require	the	addition	of	a	“virtual	preparator”	as	

well	as	a	traditional	one.	The	skills	of	a	biocommunicator	are	apt	for	filling	this	role	and	pioneering	this	

convention	shift,	by	bridging	the	gap	between	raw	CT	data,	and	polished,	easily	accessible,	and	interactive	

3D	models.		This	project	will	document	novel	workflow	of	a	virtual	fossil	preparation	of	as	well	as	

the	creation	of	interactive	virtual	models,	based	on	the	data	collected	from	the	reconstructed	virtual	

specimen.

	 In	addition	to	the	virtual	preparation	of	fossils	themselves,	accurate	digital	models	have	become	

vital	in	advancing	research,	resolving	contrasting	hypothesis,	and	assisting	in	exhibiting	findings	to	

a	wide	audience.	(Molnar	2009).	Visualization	has	traditionally	been	an	excellent	way	to	provide	a	

complete	reconstruction	of	an	extinct	species.	Illustrations	and	models	have	historically	played	a	major	

role	in	forming	concepts	of	extinct	animals	and	how	they	behaved	in	life	(Molnar,	2009).	3D	modeling	

and	animation	software	takes	this	role	to	an	even	higher	level.	Physics	based	software	such	as	Cinema 

4D, Blender and Maya	have	the	capability	of	realistically	mimicking	biomechanics	using	rigging	and	

constraints	(Molnar,	2009).	Forensic	reconstructive	methods	can	be	applied	digitally	using	Z Brush which 

permits	digitally	sculpting	musculature	and	surface	detail	over	a	skull	base.	Web	based	interactivity	

allows	the	digital	models	to	be	viewed	and	studied	in	a	three	dimensional	platform.		

	 These	advances	in	virtual	paleontology	as	well	as	digital	imaging	have	opened	a	new	world	for	

paleontology	and	specifically	for	early	primate	studies	and	chewing	mechanics.	Previously	inaccessible	

brain	cavities	surrounded	by	fragile	skulls	and	sediment	have	been	able	to	produce	virtual	endocasts	

of	three	different	adapiforms	(including	Smilodectes gracilis)	by	using	CT	scans	and	digital	processing	

(Harrington	et	al.,	2016;	Gilbert	and	Jungers,	2017)	.A	Hadropithecus	(giant	lemur)	skull,	was	also	

recently	virtually	reconstructed	to	near	completion;	accurately	displaying	this	rare	species	for	the	first	

time	(Ryan	et	al.,	2008).	The	first	volumetrically	accurate	3D	print	of	the	phelangeroid	masticatory	

apparatus	featuring	removable	muscle	layers,	was	created	using	3D	scans	and	sculpting	software	at	Johns	

Hopkins	University	(Reback,	2017;	St	Clair	et.	al.	2018).	T.	Ross	and	Diaz	have	created	virtual	models	of	
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primate	jaws	during	their	respective	gape	cycles,	demonstrating	the	actual	displacement	magnitudes	

in	real	time	(Ross	and	Diaz	2014).		These	projects	demonstrate	the	increase	value	paleontology,	and	

specifically	primate	biology	have	placed	on	digital	imaging.	

	 With	the	increased	production	of	virtual	3D	specimens	and	models	digital	sharing	has	become	

increasingly	important.	Researchers	have	been	using	the	internet	to	share	data	more	directly	(ispeCT 

applet on DigiMorph,	for	example	(Abel	et	al.,	2012)).	Organizations	such	as	The	Smithsonian	

Natural	History	Museum	have	been	sharing	data	as	well	as	publicly	providing	an	online	interactive	3D	

collection	of	fossils,	artifacts,	primates	and	other	animals	(“Human	Evolution	Evidence,	3D	Collection”,	

2018).		Sketchfab	is	a	platform	that	uses	WebGL (Web Graphics Library)	technology	to	publish,	

share,	buy	and	sell	3D Virtual Reality (VR) and Augmented Reality (AR)	content	and	supports	a	

growing	population	of	paleontologists	who	use	it	to	upload	fossil	content.	However,	a	method	of	sharing	

that	allows	public	accessibility,	high	quality	resolution	of	the	models,	and	full	interactivity	has	not	been	

established.		Technical	issues	involved	in	sharing	data	has	still	been	problematic	for	scientists	and	can	

even	be	said	to	be	holding	back	CT	based	morphological	research	(Abel	et	al.,		Sutton	et	al.,	2016)

	 In	this	project	I	will	utilize	WebGL	technology	through	Blend4Web	to	share	the	virtual	3D	models	

and	animations	created	in	this	project.	WebGL a JavaScript	application	programming	interface	for	

rendering	interactive	3D	graphics	within	any	compatible	web	browser	without	the	use	of	software	

component	add-ons	(Tavares,	Gregg,	2012).	This	technology	is	remarkable	in	that	it	makes	a	3D	model	

accessible	to	anyone	with	internet	access.	Blend4Web	is	an	open	source	framework	that	utilizes	the	

power	of	WebGL	for	creating	and	displaying	interactive	3D	computer	graphics	within	web	browsers.	

A	3D	model	can	be	exported	as	a	single	self-contained	HTML (Hyper Text Markup Language) 

file	and	embedded	within	a	web	page	using	a	standard i-frame HTML element	(Kovelenov,	2014).	

This	program	is	unique	in	that	it	provides	more	powerful	interactive	options	than	programs	such	as	

Sketchfab	without	requiring	any	coding	knowledge.		Embedding	an	HTML	file	within	a	publication	is	

entirely	plausible.	In	this	project	I	use	WebGL	technology	through	Blend4Web software to share high 

resolution,	virtual,	3D	chewing	models	and	simulation	within	a	fully	interactive	online	application.	

This	project	will	serve	as	a	model	for	the	possibilities	of	utilizing	WebGL	and	specifically	Blend4Web 

as	a	mechanism	for	sharing	fossil	data.	

	 To	create	the	first	dynamic	fully	articulated,	manipulable,	animated	and	interactive	model	of	an	

extinct	primate	for	the	study	of	chewing	biomechanics,	this	project	will	have	harness	the	full	range	of	

digital	processing	software	and	integrate	information	from	different	fields.	The	model	incorporates	
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data	from	comparative	anatomy,	functional	morphology,	and	biomechanics.	The	project	utilizes	the	full	

range	of	digital	processing	possible	moving	through	CT	imaging,	3D	sculpting,	rigging,	animation	and	

finally	online	interactive	software.	This	project	will	not	only	push	the	boundaries	of	the	study	of	early	

primate	chewing	architecture	and	dynamics	but	will	also	document	a	novel	workflow	that	utilizes	the	

full	breadth	of	digital	imaging	and	that	demonstrates	a	future	direction	of	virtual	paleontology.

4. Facial Approximation

	 The	Society	of	Vertebrate	Paleontology	has	awarded	the	John	J.	Lanzendorf	PaleoArt	Prize	for	

achievements	in	the	field	of	paleo	art	since	1999.	The	society	maintains	that	paleoart,	“is	one	of	the	

most	important	vehicle	for	communicating	discoveries	and	data	among	paleontologists,	and	is	critical	

to	promulgating	vertebrate	paleontology	across	discipline	and	to	lay	audiences.”	(Society	of	Vertebrate	

Paleontology,	1999).		

	 The	field	of	paleoart	has	been	heavily	dominated	by	subject	matter	concerning	developments	in	

dinosaur	biology.	Large	quantities	of	dinosaur	art	ranging	from	2D	illustrations,	to	physical	3D	models,	

to	virtual	3D	animations	exist	to	assist	in	communicating	data	in	the	field.		Such	a	variety	of	artistic	

representation	does	not	exists	for	extinct	primates,	save	for	those	that	are	direct	evolutionary	precursors	

of	humans.		The	artistic	representations	for	early	primates	are	generally	reduced	to	flat	2D	illustrations.		

A	virtual	3D	reconstructions	of	an	early	primate	using	reproducible	forensic	style	facial	approximation	

techniques	has	not	been	achieved.		

	 An	accurate	and	scientific	based	facial	approximation	for	early	primates	becomes	especially	

justifiable	when	the	work	of	bony	and	muscular	reconstruction	is	already	done.	The	basis	for	accuracy	

in	facial	construction	is	already	halfway	there.		The	adductor	muscles,	skull	and	jaw	make	up	most	of	

the	animal’s	facial	silhouette.		The	relative	size	and	orientation	of	the	eyes	can	be	inferred	from	bony	

orbit	size.		The	external	acoustic	meatus	being	intact	allow	for	a	reasonable	indicator	of	ear	location.		

Any	subsequent	decision	making	on	detail	can	be	made	based	of	off	living	analogs	whose	relevance	as	

accurate	references	is	backed	by	phylogeny.	

	 This	project	created	a	unique	opportunity	to	utilize	the	virtual	reconstruction	products	created	for	

more	rigorous	scientific	purposes,	as	a	means	of	producing	a	facial	approximation	of	an	early	primate	

that	is	uniquely	backed	by	anatomically	justified	decision	making.		This	creates	a	further	example	of	the	

capabilities	of	paleontological	imaging.
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5. Objectives:

		 This	project	aims	to	contribute	to	the	study	of	early	primate	origins	by	presenting	an	interactive	

web	based	application	featuring	a	polished	set	of	virtual	three	dimensional	reconstructions	of	one	of	the	

earliest	primate	species, Smilodectes gracilis,	including	a	rigorously	refurbished	skull,	3D	representations	

of	novel	chewing	muscle	data,	and	an	animated	chewing	simulation	which	brings	the	static	numerical	

data	to	life.	The	contribution	of	these	visualization	tools	will	hopefully	illuminate	a	portion	of	the	often	

convoluted	and	controversial	discussion	of	primate	origins	as	well	as	demonstrate	the	full	potential	and	

value	of	virtual	planetological	imaging.	The	specific	goals	include	the	creation	of:

A	virtual	3D	model	of	a	fully	restored	skull	of	Smilodectes gracilis	derived	from	the	CT	

data	of	an	individual	fossil	specimen.	

	Virtual	3D	jaw	adductor	muscle	models	based	on	muscle	size	estimates	gleaned	from	

measurements	taken	off	the	restored	skull.	

	An	animated	a	chewing	simulation	of	the	muscles	and	jaw	engaged	in	a	typical	gape	

cycle	based	on	documented	primate	biomechanical	chewing	data.

	A	virtual	3D	facial	approximation	using	sculpting	software	and	basic	forensic	

reconstruction	techniques.	

	A	fully	interactive	online	application	to	display	the	previously	described	models	and	

simulations.	The	application	will	be	allow	full	manipulation	of	the	models	and	include:	

control	of	individual	muscle	visibility,	highlighted	muscular	origins	and	insertions,	

and	zoom,	pan,	and	rotate	features.	

	A	reproducible	workflow	detailing	the	steps	of	moving	from	CT	fossil	data,	to	virtual	

reconstruction,	to	rigging	and	animation,	to	web	optimization	and	finally	online	

accessibility.		

6. Significance of the Study:

 This	project	brings	new	understanding	of	ancient	primate	chewing	architecture	and	dynamics	by	creating	

a	digital	3D	reconstruction	of	a	Smilodectes	skull,	chewing	musculature,	and	chewing	behavior	and	thus	

contributes	to	the	continued	study	of,	and	education	about,	the	primate	evolutionary	tree.	The	interactivity	of	

the	model	and	simulation	will	set	a	standard	for	how	fossils	and	3D	reconstructive	work	are	presented	within	

the	scientific	community.	The	project	also	contributes	to	the	biocommunication	field	by	bridging	the	gap	

between	raw	CT	data,	and	polished,	easily	accessible,	and	interactive	3D	models.	
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mAterIAls And methods:

1. Data Acquisition and Processing 

	 A	fossil	specimen	of	Smilodectes gracilis	was	borrowed	by	the	Department	of	Functional	Anatomy	

and	Evolution,	Johns	Hopkins,	from	the	Denver	Museum	of	Nature	and	Science	in	2014.		The	specimen	

(DMNH	10000)	includes	a	fossilized	cranium,	mandible	(both	sides)	and	proximal	tibia.		Three	

dimensional	data	were	obtained	from	computer	tomography	at	a	slice	resolution	of	0.1063	mm	using	

an	Industrial	High	Resolution	CT/S	Ray	Scanner	located	at	the	Duke	University	Shared	Materials	

Instrumentation	Facility.		2065	images	resulted	from	the	scan	of	the	cranium	and	1603	images	of	the	jaws	

and	proximal	tibia.	

1.1 Segmenting and Isosurface Creation using AVIZO 

AVIZO	7.0	software	(FEI	Visualization	Sciences	Group)	was	used	to	view	and	process	CT	data.		The	

images	were	viewed	by	importing	the	data	sets	(Open > select all images in stack),	right	clicking	on	

the data set and selecting Orthoslice.		The	contrast	and	brightness	were	adjusted	in	the	Data window to 

visualize	the	data.		The	data were	segmented	by	selecting	the	data	set	and	using	the	magic	wand	tool	to	

select	the	bone	while	eliminating	background	and	other	sediment	surrounding	the	bone	(Magic wand tool 

> Check box all slices, Add selection to current material > save data as). A surface model was created 

using	the	Generate	surface	function	(select .tif-lable data set > Generate surface > Apply, Surface tab 

> view > shaded).	The	final	model	was	exported	as	an	OBJ	file.	The	process	was	repeated	with	the	jaw	

data (fig 3).	

Figure 3. Screen shots of the (A) Isosurfaces of the mandibles and the (B) Isosurface of the cranium, within AVIZO software.

A B
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2. Virtual Skull Restoration using Z Brush

	 The	digital	three	dimensional	cranium	and	jaw	of	the	Smilodectes graclis	specimen	was	virtually	

restored using the Z Brush;	a	polygonal-based	3D	modeling	software.	Much	of	the	sediment	surrounding	

the	bony	structures	had	been	segmented	from	the	bone	during	the	pre-processing	in	the	AVIZO	software.	

The	resulting	fossil,	however,	was	still	highly	fragmented,	distorted	and	significantly	encumbered	

with	sediment.		Several	strategies	were	used	in	making	educated	decisions	on	what	changes	would	be	

appropriate	in	order	to	restore	the	specimen	as	accurately	as	possible.	These	strategies	were	in	line	with	

fossil	preparatory	literature,	which	documents	best	practices	in	the	physical	preparation	of	a	fossil	for	the	

purpose	of	research.		It	is	believed	by	some	preparators that	when preparing	a	fossil	“as	much	information	

as	possible	is	conserved	in	the	natural	object”	(Brown	et	al.,	2009).		This	conservative	approach	was	used	

during	the	digital	“preparation”	of	the	specimen	in	that	only	the	most	necessary	changes	were	made,	in	

order	to	keep	as	much	of	the	original	data	intact	as	possible		The	changes	themselves	were	made	using	a	

variety	of	techniques	in	Z Brush.	The	major	strategies	and	techniques	used	in	refurbishing	the	skull	and	

jaw	are	divided	into	Referencing Techniques and Digital Techniques,	which	are	listed	in	the	following	

sections.

2.1 Reference Techniques 

 2.1.1 Aligning Dentition

	 No	major	fractures	or	distortion	could	be	identified	on	either	the	upper	or	lower	teeth	on	the	specimen.		

The	teeth	could therefore	be	aligned	and	used	as	a	starting	point	for	making	conclusions	about	where	

other	anatomical	landmarks	should	be	located	(fig 4). The	jaw,	for	instance,	was	relatively	complete	

and	undamaged;	therefore,	once	the	teeth	had	been	aligned	a	confident	estimate	of	the	location	of	the	

Figure 4. Screen shots showing the process of aligning the dentition of the jaw to the dentition of the cranium within Z Brush.. 
The cranium has been “hidden” within Z Brush for clarity.
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temporomandibular	joint	point	could	be	made.	The	articular	surface	of	the	mandibular	fossa	of	the	

temporal	bone	was	almost	10mm	more	rostral	than	the	condyle	of	the	jaw.	A	clear	fracture	could	also	be	

seen	across	the	surface	of	the	cranium	with	sections	of the	posterior	portion	were	overlapping	the	anterior	

portion.		Based	on	these	observations,	the	decision	was	made	to	move	the	posterior	portion	of	the	skull	

(following	the	overlapping	fracture)	caudally	until	the	articular	surface	of	the	mandibular	fossa	aligned	

with	the	condyle of	the	jaw.	

2.1.2 Model References

	 A	specimen	of	Propithetcus coquereli	was	provided	for	reference	as	well	as	an	enlarged	dental	model	

of	MI,	M2,	M3	of	Cantius ralstoni (fig 5).		These	physical	three	dimensional	references	were	useful	

gaining	in	understanding	of	overall	dimension	and	shape	as	well	as	specifics	as too	tooth	alignment	and	

jaw	articulation.

2.1.3 Fracture Patterns 

	 By	following	the	fracture	patterns	in	the	specimen,	fragments	could	be	isolated	and	moved	

individually.	Segments	of	the	cranium	were	clearly	overlapping	each	other.	By	following	the	fracture	

patterns	these	segments	could	be	moved	back	into	place.	Other	segments	were	spread	apart	and	could	

be	brought	back	together	and	fit	as	if	a	puzzle.	By	paying	particular	attention	to these	and	other	fracture	

patterns	the	specimen	could	be	adjusted	in	a	logical	way	(fig 6).

Figure	5.	 Photographs	of	reference	models	including,	a	(A)	dental	model	of	M1,	M2,	M3	on	Cautius	ralstoni	(a close relative of 
Smilodectes)	and a (B) cranium of	Propithetcus	coguereli	(an extant lemur).	Photo	credit:	Amanda	Slade	2018.

A B
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2.1.4 Reference Photos 

	 Detailed	photographs	of	five	other	fossilized	specimens	of	Smilodectes gracilis	were	available	for	

reference,	provided	by	the	Johns	Hopkins	Department	of	Functional	Anatomy	and	Evolution.		Each	of	

these	specimens	was	damaged	and	distorted	in	distinct	ways	and	had	other	features	that	were	more	or	

less	preserved.		By	comparing	each	of	these	images	to	the	digital	specimen,	as	well	as	to	one	another,	

decisions	on	changes	to	make	on	the	specimen,	were	made	confidently.	Features	that	were	checked	when	

making	these	comparisons	included:	

	 (1)	Comparing	the	ratio	of	jaw	to	skull	length	(if	a	jaw	was	available).	

	 (2)	Measuring	relative	distances	between	bony	landmarks.	

	 (3)	Referencing	common	features	such	as	orbits,	temporomandibular	joints,	and	major	foramina.	

	 4)	Referencing	how	the	“bite”	of	the	specimen	and	how	their	dentition	aligned.	

	 (5)	Referencing	missing	anatomy.	

2.1.5 Expert Opinion

	 Dr.	Jonathan	Perry,	of	the	department	of	Functional	Anatomy	and	Evolution	at	Johns	Hopkins,	studies	

the	chewing	anatomy	of	primates.	He	was	able	to	use	his	background	and	years	of	training	and	research	to	

give	feedback	on	how	the	cranium	was	to	be	altered,	as	well	as to	check	the	progress	along	the	way.

Figure 6. Screen shot of a masked section of the specimen that follows a fracture pattern in Z Brush.



15

2.2 Digital Techniques 

2.2.1 Reorientation

	 When	OBJ	files	of	the	segmented	CT	cranium	and	jaw	data	were	imported	into	Z Brush	they	were	

oriented	in	a	skewed	position	and	not	aligned	in	relation	to	one	another.		Using	the	Move Transpose	tools,	

the	cranium	was	rotated	and	moved	to	align	with	the	program’s	orthogonal	orientation.		The	jaw	was	

placed	in	a	logical	position	in	relation	to	the	cranium	(fig 7).

2.2.2 Organizing Geometry 

Polygroups and Sub Tools	allow	a	mesh	to	be	organized	with	visual	grouping	within	Z Brush.		Sub 

Tools	create	separate	pieces	of	geometry	and	Polygroups	create	separate	selection	areas	within	a	piece	of	

continuous	geometry.	These	organization	tools	were	used	to	separate	fragments	of	anatomy	and	move	and	

rotate	them	individually.		

2.2.3 Removing Sediment 

 The Lasso tool	was	used	to	select	portions	of	the	mesh	that	appeared	to	be	sediment,	this	geometry	

was then deleted (Hide Geometry > Delete Hidden).	If	any	holes	in	the	mesh	were	created	from	the	

process,	then	Close Holes	was	used	to	fill	the	missing	geometry.	

2.2.4 Recreating Missing Anatomy  

	 Significant	portions	of	the	jaw	and	cranium	were	missing	entirely.		The	nasal	region,	interior	of	the	

orbits,	and	several	teeth	were	missing	data.	These	areas	were	recreated	by	creating	a	new	Sub Tool of a 

sphere	(Sub Tool < Append < Sphere).	The	sphere	is	then	moved	and	scaled	using	the	scale	and	move	

tools	to	the	area	needing	reconstruction.	Using	the	Move brush	the	sphere	is	reshaped	to	resemble	the	

A B

Figure 7. Screen shots of a (A) superior view of the cranium and jaw having been oriented in Z Brush and a (B) 
lateral view of the jaw having been oriented to fit the cranium.
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anatomy	of	a	reference	(see 2.1.2, 2.1.4).	The	Standard brush and Smooth tool were used for detail 

refinement.		Shapes	were	kept	fairly	general	and	fine	detail	was avoided	to	ensure	that	features	being	

recreated	would	not	be	assumed	to	be	real	(fig 8).	

	 The	changes	made	to	the	digital	specimen	were	made	only	when	an	educated	reason	could	be	given	

based	on	the	previously	listed	strategies.	The	resulting	model’s	deformations	and	distortions	are	corrected,	

and	almost	all	of	the	information	the	original	fossil	contained	is	preserved.

3. Virtual Skull Reconstruction using Z Brush

	 A	full	reconstruction	of	the	specimen	was	creating	with	the	intention	of	recreating	the	anatomy	of	an	

average	member	of	the	species	rather	than	preserving	the	anatomy	of	an	individual	(as	in	the	restoration	

of	the	selected	specimen	(see	section	2.).		The	full	reconstruction	utilized	much	more	artistic	license	and	

created	an	approximation	as	to	what	a	completely	undamaged	skull	of	an	average	Smilodectes gracilis 

would	look	like.		All	reconstruction	was	done	within	Z Brush.	The	techniques	used	for	this	process	are	

listed	in	the	sections	below.		

Figure 8. Screen shots of the recreated anatomy of the virtual specimen in Z Brush
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3.1 Symmetrization 

	 To	ensure	the	reconstructed	model’s	symmetry	the	refurbished	model	was	cut	in	half	along	the	

midsagittal	plane.	Subsequent	sculpting	and	adjustments	were	then	made	to	only	one	half	of	the	model.		

When	sculpting	and	refinement was	complete	the	half	was	duplicated	(Tools > Sub Tools > Duplicate),	

mirrored (Tools > Deformation > Mirror),	and	merged	(Tools > Sub Tools > Merge > Merge Down).

3.2 Smoothing Restored Skull

	 The	refurbished	model	was	used	as	a	starting	point.		All	Sub Tools	of	individual	fragments	as	well	

as	the	reconstructed	areas	of	missing	anatomy	were	merged	into	a	single	Sub Tool.	The	jaw	and	cranium	

were	kept	separate	pieces	of	geometry.		The	fissures	and	fractures	were	then	repaired	using	the	Smooth 

tool.	

3.3 Sculpting Techniques

	 A	sphere	was	appended,	moved	to	the	appropriate	location	and	sculpted	over	the	refurbished	model.	A	

new	version	of	the	anatomy	was	sculpted	on	top	of	the	refurbished	specimen’s	anatomy,	which	allowed	for	

the	refurbished	model	to	be	used	as	a	guide	for	reconstructing	the	model.		Once	the	appended	object	was	

sculpted	in	a	way	that	appeared	correct,	it	could	be	merged	down	and	incorporated	into	the	model.		This	

method	allowed	for	the	model	to	be	recreate	piece	by	piece	ensuring	a	thorough	approach.

3.4 Recreating Dentition

	 Because	the	reconstructed	model	was	ultimately	used	as	a	chewing	model,	recreating	an	accurate	

“bite” was	important.		Each	tooth	was	made	into	its	own	Sub Tool	so	it	could	be	manipulated	

independently	(fig 9).		Each	tooth	was	sculpted	to	ensure	that	it	fit	within	among	the	surrounding	teeth	and	

to	ensure	that	it	preserved	a	realistic	“bite”	with	the	occluding	teeth	during	mastication.

Figure 9. Screen shot of an individual tooth being made into a Sub Tool, in Z Brush, so that it can be  manipulated 
independently of the surrounding dentition .  Transparency is enabled.
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4. Virtual Mastication Muscle Reconstruction 

	 The	three	jaw	adductor	muscles	were	chosen	for	the	reconstruction;	the	masseter,	temporalis,	and	

medial	pterygoid.	A	method	of	estimating	muscular	volume	developed	by	Dr.	Perry	was	utilized	for	

making	the	measurements.	The	estimates	are	based	on	the	bony	features	of	the	skull	and	jaw	that	indicate	

origins	and	insertions	of	the	musculature.	Accurate	measurements	could	not	be	made	on	the	physical	

specimen	due	to	sediment	impacting	potions	of	the	necessary	osteological	landmarks,	distortion	of	the	

specimen,	and	other	damage.	Measurements	were	able	to	be	made	on	the	refurbished	digital	skull	within	

GEOMAGIC software.	 GEOMAGIC	software	is	a	professional	engineering	software	which	has	an	

emphasis	on	3D	scanning	and	surface	manipulation..			

4.1 Scale verification 

 Real life scale within Z Brush	stays	consistent	with	the	imported	OBJ	file.		Any	processing	within	

Z Brush	was	to	scale	with	the	physical	specimen.		After	exporting	the	refurbished	digital	specimen,	

the	relative	scale	was	unaltered	when	the	object	was	imported	into	GEOMAGIC.		This	was	verified	

by	making	dimensional	measurements	on	the	physical	specimen	and	comparing	them	with	the	digital	

specimen’s	scale	in	GEOMAGIC.

4.2 Surface Area Measurements in GEOMAGIC

	 The	digital	skull	was	loaded	into	GEOMAGIC.  The Paint tool	was	used	to	paint	the	surface	area	

of the origins and insertions of each muscle (fig 10).	The	surface	areas	of	the	painted	regions	were	then	

isolated	from	the	rest	of	the	anatomy.		The	Fill Holes	function	was	used	to	fill	any	major	holes	or	gaps	in	

the	surface	that	were	created	by	fractures	in	the	fossil (fig 11 A, B)	or	imperfections	in	the	transfer	from	

CT	data	to	surface	model.	Some	holes	were	left	unfilled	because	filling	them	resulted	in	major	distortions	

of	the	original	anatomy.  The area of the surface was then calculated using the Selected By Area function 

(fig 11 C, D). The	surface	areas	of	each	origin	and	insertion	were	saved	and	exported	as	OBJ.	files	to	be	

used	for	reference	during	muscle	sculpture.	
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Figure 11. Screenshots in GREOMAGIC of (A) the Fill Holes function being performed on the insertion of the masseter 
object, (B) the Fill Holes settings used, (C) the surface area being calculated on the origin of the medial pterygoid, and (D) 

the output of the Select by Area function. 

A

B

C D

Figure 10. Screenshot in GEOMAGIC of the surface area for the 
insertion of the masseter painted onto the mandible. 
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4.3 Numerical Muscle Volume Estimates 

Dr.	J	Perry,	of	the	Department	of	Functional	Anatomy	and	Evolution	at	Johns	Hopkins	University	used	

the	surface	areas	extracted	in	GEOMAGIC to	calculate	volume	estimate	of	each	of	the	three	adductor	

muscles.	The	resulting	volumes	are	listed	in	(fig 12.)

Jaw Adductor Muscle Volume Estimate (cm3)
Masseter 4.18	
Temporalis	 4.74

Medial	Pterygoid 2.75

4.4 Extracting Origin and Insertion Surface Areas in Z Brush

	 OBJ	files	of	the	surface	area	for	the	origin	and	insertions	for	each	muscle	were	uploaded	into	Z Brush 

and	appended	into	the	reconstructed	skull	file.		Each	of	these	were	made	into	a	separate	Sub Tool and 

positioned	over	the	skull	model	using	transparency	mode	so	that	the	shape	could	be	accurately	placed	(fig 

13 A).		A	mask	was	applied	to	the	area	using	the	origin/insertion	Sub Tool as a guideline (fig 13 B).		A	

new	mesh	was	extracted	(Tools > Sub Tools > Extract > Apply; Smt = 5, Thick = .05) (fig 13 C).

4.5 Sculpting Appended Objects in Z Brush

	 A	sphere	Sub Tool	was	appended	and	sculpted	into	the	general	shape	of	the	muscle	using	the Move 

brush,	Dyna Mesh and Smooth tools.		The	origin	and	insertions	of	each	shape	were	matched	with	the	

origin	and	insertion	meshes	extracted;	these	Sub Tools	were	then	merged	into	single	piece	of	geometry.			

4.6 Subtracting Overlaps in Z Brush

 Boolean	subtracting	operations	were	performed	to	eliminate	overlaps	between	layers	of	adjoining	

meshes.		With	the	selected	Sub Tool in Dyna Mesh mode and the Sub Tool	to	be	merged	assigned	the	

White	Polygroup (Group As Dyna Mesh Sub)	a	merge	down	operation (Tool > Sub Tool > Merge 

Down)	was	used	to	subtract	the	merged	mesh	from	the	current	one.	This	allowed	the	junction	between	the	

muscle	and	the	bone	to	fit	perfectly.

Figure 12. Table listing the jaw adductor muscle estimates in 
centimeters cubed. 
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Figure 13. Screen shots of the (A) “origin” Sub Tool of the temporalis positioned correctly, the (B) mask painted following the 
origin Sub Tool as a guideline, and the (C) mesh extracted from the mask. 

A

B

C
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4.7 Volume Verification in Blender 

 The muscle Sub Tools	were	exported	as	OBJ	files	and	brought	into	Blender	for	volume	determination.

The	3D Print Plugin	was	installed	in	order	to	use	the	volume	feature	in	Blender (fig 14).	In	Object 

Mode	the	object	was	selected	and	a	volume	operation	was	performed	(3D print > Statistics > Volume).	

The	volume	in	cm3	appears	in	the	Output.		Adjustments	were	made	within	Blender under Sculpt Mode.		

The Grab tool	was	used	to	make	bulk	adjustments.		

Care	was	taken	to	ensure	the	borders	and	surfaces	of	the	

origin	and	insertions	sites	remained	unaltered.	When	the	

volumes	were	roughly	the	correct,	the	muscle	objects	were	

exported	from	Blender	and	imported	back	into	ZBrush 

for	additional	detailed	sculpting.		When	the	models	were	

complete	they	were	exported	and	measured	a	final	time	

within Blender.	

4.8 Adding Texture and Fiber Direction in Z Brush

The Clay Buildup	brush	was	used	to	create	raised	

topology	of	the	muscles	fiber	and	Damien Standard 

brush	was	used	to	indicate	more	precise	lines	and	creases,	

as	well	as	finer	muscle	fibers.	Dyna Mesh was used to 

continuously adjust	the	topology	of	the	mesh (fig 15). 

	 Reference	photos	and	illustrations	were	used	while	

sculpting	the	musculature.		Details	such	as	typical	muscle	

shape,	fiber	direction	and	typical	connective	tissue	patterns	

were	closely	observed	in	these	references	to	ensure	the	

reconstructions	were	as	accurate	as	possible.	

B

A

Figure 14. Screen shot of Blender interface 
showing 3D Print Plugin tab including the (A) 
Volume button and (B) the Volume Output field.
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Figure 15. Screen shots of the (A) basic muscle shape, (B) Damien standard being used 
to make major muscle fiber groups and (C) finer muscle fiber detail.

A

B

C
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5. Facial Approximation in Z brush

	 3D	digital	reconstruction	of	Smilodectes gracilis	surface	anatomy	was	created	using	Z Brush.  

Although	facial	musculature,	fatty	deposits,	vasculature,	and	glandular	tissue	were	not	reconstructed,	

the	major	underlying	anatomy	was	enough	to	give	an	estimate	of	what	the	surface	features	could	have	

looked	like.	

	 Using	the	transparency	option,	the	reconstructed	skull,	jaw	and	musculature	were	visualized	as	

surface	sculpting	took	place	(fig 16).		A	sphere	was	appended	and	the	Move brush was used to create a 

surface	layer	surrounding	the	underlying	anatomy.	The Standard and ClayBuildUp	brushes	were	used	

for	establishing	larger	features.		Damien Standard brush	was	used	for	creating	lines	and	creases.		The	

DynaMesh	tool	was	used	throughout	the	sculpting	process	to	retopologize	the	mesh.					

	 The	ears	and	eyes	were	created	as	separate	SubTools	and	placed	based	on	landmarks	on	the	skull.		

The	sculpts	of	the	ears were	placed	in	relation	to	the	external	auditory	meatus	and	the	eye	balls	were	

placed	within	the	orbits	with	enough	space	surrounding	them	to	account	for	the	extraocular	musculature	

and	other	anatomy	(e.g.,	fat	and	fascia).

	 Once	the	major	features	and details	were	sculpted,	and	fur	was	added	around	the	areas	based	on	

reference	photos	of	living	analogs.	Other	details	were	also	included	like	eyelids,	whisker	indentations	

and	texture	on	the	nose.	

Figure 16. Screenshots of (A) underlying anatomy visible within the transparent surface sculpt and  
(B) the basic surface anatomy sculpt of Smilodectes Gracilis.

BA
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	 The	photographs	used	as	references	were	photos	of	Smilodectes gracilis’s	most	direct	living	

equivalents	such	as	the	Brown	Lemur	(Eulemur fulvus).		Artistic	interpretations	of	Smilodectes gracilis 

were	also	used	along	with	those	of	closely	related	extinct	genera	including	Adapis and Notharctus.			

6. Optimizing Meshes for a Web Application using Z Brush and Blender

	 All	the	models	created	were	designed	to	be	ultimately	inserted	into	an	interactive	online	application.		

The	speed	of	loading	such	an	application	is	linked	to	the	size	of	the	file.		In	order	to	ensure	that	the

application	could	be	loaded	in	a	reasonable	amount	of	time	without	sacrificing	any	quality	of	detail	the	

models	needed	to	be	prepared	for	the	web.	This	process	involves	using	a	high	to	low	poly	workflow.		A	

low	polygon	model	is	created	using	the	original	high	polygon	sculpt using	tools	provided	in	Z Brush.		The	

low	polygon	and	high	polygon	models	are	both	exported	into	blender	and	the	detail	of	the	high	polygon	

model	can	be	“baked”	onto	the	low	polygon	model	by	UV unwrapping the models and creating a normal 

map.	Using	the	normal	map	as	a	texture,	the	low	polygon	model	can	have	the	same	level	of	detail	as	the	

high	polygon	model	while	vastly	reducing	the	amount	of	render	time.		The	reconstructed	cranium,	jaw,	

masseter,	temporalis	and	medial	pterygoid	were	all	brought	through	the	process	outlined	below.	

6.1 Creating a Low Poly Model in Z Brush 

The Decimation Master	is	simple	way	to	reduce	

the	level	of	polygons	in	a	mesh	in	a	way	that	maintains	

the	integrity	of	the	original	model.		Decimating	by	

40-100%	will	leave	the	detail	almost	entirely	intact	

(100%	means	no	decimation	and	.01%	means	maximum	

decimation),	while	below	40%	will	begin	to	reduce	the	

resolution	significantly.		Creating	a	low	poly	model		

requires	only	that	the	silhouette	of	the	model	remain

relatively	unchanged	while	the	detail	does	not	need	to	be	

maintained	as	it	will	be	baked	into	the	model	at	a	later	

time.	With	the	Sub Tool	selected	for	decimation	the	model	was	preprocessed	(Z Plugin > Decimation 

Master > Preprocess current).		When	the	preprocessing	was	complete,	the	model	was	decimated	to	30%	

(Z plugin > Decimation Master > Decimate).

Figure 17. Screen shot of ZRemesher  
settings in ZBrush.
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6.2 Retopologizing Models 

	 Decimating	the	model	reduces	the	number	of	polygons	quickly	however	the	topology	created	can	be	

messy	and	make	the	following	step	of	unwrapping	the	mesh	difficult.		The	ZRemesher (Tool > Geometry 

> ZRemesher )	is	used	to	create	cleaner	topology	that	is	easier	to	unwrap.	The	default	settings	were	used	

in each case (fig 17).

6.3 UV Maps in Blender

	 To	unwrap	the	low	poly	meshes	to	create	UV maps	they	are	imported	into	Blender.	Seams	are	created	

in the	mesh	to	facilitate	unfolding	into	a	flat	shape.		To	create	a	seam,	the	object	is	put	into	edit	mode	and	

edges	are	highlighted	using	the	edge	select tool	and	pressing	shift	while	clicking	edges.		When	a	seem	is	

complete	it	is	marked	using	the	Mark Seam function (Shading / UVs < UV Mapping < Mark Seam) 

(fig18).	When	the	seams	are	complete	the	mesh	is	unwrapped	by	selecting	the	entire	mesh	(hotkey < A),	

accessing	the	unwrap	menu	(hotkey < U),	and	selecting	Unwrap.		To	view	the	resulting	UV map the 

screen	is	split	and	the	UV / Image Editor 

is selected under Editor type (fig 19).		

The	resulting	image	shows	depicts	the	

mesh	unwrapped	into	a	flat	image	along	

the	selected	seams.	

6.4 Normal maps in Blender

	 With the	UV maps	created,	the	

normal	map	can	now	baked	onto	the	low	

poly	mesh	from	the	high	poly	mesh.		The	

high	poly	mesh	is	imported	into Blender 

and	positioned	in	the	exact	same	position	

as	the	low	poly	mesh. In	the	Outliner 

panel,	the	high	poly	mesh	is	selected	first	

and	the	low	poly	mesh	second,	by	holding	

shift	and	selecting.	Within	the	Bake 

menu,	Normal is selected as the Bake 

Mode and the Bake button	is	pressed	

(Properties < Render < Bake)	(fig 20).		
B

A

Figure 18. Screen shots of (A) Blender seam selection in  
(B) Edit mode. 
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Figure 19. Screen shot of Blender interface showing a (A) UV Mapping menu and a (B) split screen with 
the UV map shown in the UV/Image Editor type

Figure 20. Screen shots of (A) Normal map mapped onto the UV map and (B) the Bake 
menu with the Bake mode set to Normals.

B

A

BA

Figure 21. Screen shots of Blender medial pterygoid muscle mesh showing the (A) high and low poly meshes before the normal 
map is applied to the low poly mesh and the (B) high and low poly meshes after the normal map is applied to the low poly mesh. 

.

A B
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Figure 22. Screen shot of Blender show
ing the texture painting interface. Areas of interest are highlighted. N

ot all text is intended to be read.
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Within	the	UV / Image Editor	the	normal	map	will	appear	mapped	out	onto	the	UV	map	previously	

created.	The	normal	map	should	be	saved	as	a	png.	(Image < Save As Image).

	 To	apply	the	normal	map	to	the	low	poly	mesh	the	saved	png	file	is	loaded	as	a	texture.	A	new	

material	is	created	under	the	material	tab	in	the	Properties editor,	a	new	texture	is	then	created	under	

the	texture	tab.		The	normal	mapped	previously	saved	is	then	loaded	into	the	texture	(Texture < Type 

< Image or Movie, Image < open).		In	order	for	the	normal	map	to	be	seen	on	the	low	poly	mesh,	

the Normal map	check	box	must	be	checked	under	Image Sampling,	and Color	must	be	unchecked	

and Normal	checked	under	Influence. 	The	normal	map	appears	on	the	low	poly	object	and	is	almost	

indistinguishable	from	the	high	poly	mesh	(fig 21).

 
6.4 Texture painting in Blender

	 Each	of	the	objects	was	individually	painted	using Blender’s texture	painting	tool (fig 22).		This	

feature	allows	painting	to	occur	directly	onto	the	mesh.		It	is	also	possible	to	keep	the	texture	activated	

and	details	of	the	sculpt	can	be	viewed	while	painting	the	model.		The	texture	painting	feature	is	

accessed in the Texture Paint edit mode.		With	a	split	screen,	the	second	screen	is	set	to	the UV / 

image editor and painting	can	be	seen	on	the	UV	map	and	the	mesh	simultaneously.			A	new	texture	

is	added	by	selecting	a	new	material	under	the	Slots tab.		This	texture	appears	under	the	Available 

Paint Slots	and	is	selected.		The	mesh	turns	to	a	default	black	color	and	is	able	to	be	painted	on	using	

the	brushes	and	color	selector	in	the	Tools tab.	Detailed	textures	were	hand	painted	onto	each	of	the	

muscles	as	well	as	the	skull,	jaw	and	teeth.	

7. Creating a Chewing Simulation in Blender

	 To	create	an	accurate	chewing	simulation,	armature	animation	was	used	to	recreate	the	chewing	

movements.		This	methods	utilized	the	software’s	kinematic	system	to	simulate	the	physical	

capabilities	and	limitations	of	actual	craniomadibular	movement.

7.1 Rigging the model 

	 Rigging	is	a	process	used	in	armature	animation	in	which	a“skeleton”	is	created	out	of	a	set	of	

interconnected	“bones”	which	is	then	attached	to	the	vertices	of	a	mesh	model.	This	armature	can	

then	be	posed	and	keyframed	and	the	vertices	of	the	mesh	will	follow	it.		The	armature	itself	serves	as	

nothing	more	than	an	intuitive	handle	for	the	animation	process	and	does	not	appear	in	any	 

rendering.	(Soriano,	2011.	)
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7.1.1 Creating Armatures

	 In	order	to	ensure	that	all	muscles	moved	in	response	to	the	jaw,	the	rigging	was	created	in	a	

systematic	way.		The	jaw	movement	was	rigged	first	and	each	muscle	was	then	added	subsequently	to	the	

rig.		Specialized	armatures	were	then	added	to	modify	each	muscle’s	movement.	

	 An	armature	was	created	by	adding	a	Single Bone (Add > Armature > Single Bone)	into	the	scene.		

The	display	of	the	bone	can	be	adjusted	by	selecting	the	options	in	the	Armature	tab	under	Properties 

(Properties > Armature > Display).		The	X-Ray	option	was	used	to	allow	for	the	bone	to	be	seen	through	

the	model.		While	initially	constructing	the	model	the	Octahedral	display	was	chosen	and,	as	the	armature	

became	more	complex,	the	Stick	display	was	used	(fig 23).	

	 In	order	to	add	to	the	Single Bone and create a full armature the Bone was selected and the mode 

was switched to Edit Mode.	Here	the	armature	will	always	remain	in	a	“rest”	position,	whereas	in	

Object Mode and Pose Mode, the	current	“pose”	of	the	armature	will	show.		A	Bone	is	made	up	of	three	

elements (fig 24): The Root	or	“start	joint”,	the	Body,	and	the	Tip	or	“end	joint”.		Each	of	these	elements	

are	able	to	be	manipulated.	To	add	bones	to	an	existing	bone	either	then	Tip	or	Root	can	be	selected	and	

Figure 23. Screen shots of Blender showing a Single Bone being added to the scene and the Armature 
Display options.  Not all text is intended to be read.
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Extrude	a	new	bone	(Armature > Extrude).		The	new	bone	will	be	the	

“child”	of	its	Tip	owner	and	connected	to	it.	When	the	original	bone	is	

moved	its	child	will	move	with	it.	

	 The	armature	used	to	move	the	jaw	was	created	in	such	a	way	

that	all	bones	within	the	armature	were	children	of	a	single	parent	

(or “Control”)	bone.		When	this	“Control Bone”	is	moved,	all	bones	

connected	to	it	would	move	with	it.		The Control Bone	was	placed	in	the	

midpoint	between	the	condyles	of	the	mandible	and	positioned	so	

that its Root	was	perpendicular	to	the	helical	axis	of	rotation	of	

the	jaw	(fig 25). 

Figure 24. Screen shots  
of Blender  showing the three  

elements of a Bone.

Figure 25. Screen shots in Blender showing (A) the positioning the Root of the Bone in Octahedral display to align with the 
helical axis of the jaw and (B) positioning in the Bone to reside in the midpoint between the mandibular condyles along the 

helical axis shown in yellow.

A B

Figure 26. Screen shots in Blender showing (A) frontal view of the jaw armature in Stick display (B) lateral view of the jaw 
armature with the helical axis of the jaw shown in yellow.

A B
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	 Connecting	bones	were	then	assembled	using	the	Extrude	function	to	follow	the	form	of	the	jaw	

and	lower	teeth.	The	joint	points	of	the	mandibular	condyles	were	carefully	aligned	with	the	Root of the 

Control Bone	along	the	helical	axis.

7.1.2 Parenting Armatures and Posing 

	 The	armature	was	then	attached	to	the	mesh	of	the	jaw	by	parenting	the	armature	with	the	the	mesh.		

In	Object	mode	the	jaw	mesh	was	selected	and	then	by	holding	shift	the	armature	was	also	selected.		The	

parent	With Automatic Weights	function	was	performed	(Object > Parent > With Automatic Weights).	

In	order	to	ensure	that	the	armature	was	affecting	the	mesh	in	the	desired	way	the	mode	was	switched	

to Pose Mode and the Control bone	was	selected	and	rotated	around	the	Z	axis.	If	the	parenting	was	

successful,	the	jaw	would	move	in	unison	with	the	armature. (fig 26).

7.1.3 Adding Muscles to Jaw Armature

	 Once	the	armature	for	the	jaw	movement	was	established,	the	muscles	were	parented	to	the	armature	

so	that	they	would	respond	to	the	jaw	as	it	was	posed.		The	muscles	were	parented	systematically	and	

additional	bones	were	created	to	adjust	how	each	muscle	responded.		These	additional	bones	added	to	the	

armature	were	added	for	one	of	two	purposes:	

(1)	To	anchor	part	of	the	muscle	to	ensure	it	would	not	be	affected	by	jaw	movement.	

(2)	To	assist	the	initial	jaw	armature	to	ensure	a	part	of	the	muscle	would	be	affected	by	jaw	movement.	

The	bones	added	specifically	for	each	muscle	are	shown	in	figure 27	as	is	the	completed	armature.

	 To	simplify	the	animation	process	and	due	the	limitations	of	the	Blend4Web software in the 

interactivity	stage,	the	jaw,	lower	teeth,	and	all	three	adductor	muscles	were	joined	into	a	single	object	

(shift select all objects > object > join)	and	re-parented	to	the	completed	armature.	The	jaw	was	rotated	

using	the	control	bone	to	test	if	all	armatures	were	working	in	the	same	way	that	they	were	when	the	

objects	were	separated.		If	one	bone	was	affecting	a	muscle	it	was	not	supposed	to,	then	the	bone’s	position	

would	be	adjusted.		
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A B
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D E

Figure 27. Screen shots in Blender showing (A) bones created for the medical pterygoid, (B) bones created for the masseter, 
(C) bones created for the temporalis, and (D), (E) two views of the final armature including all bones and all muscles.
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7.1.3 Weight Painting

	 The	effect	each	individual	bone	had	

on	a	mesh	could	be	checked	by	viewing	

the mesh in Weight Painting mode.		Here	

the	amount	of	influence	a	particular	bone	

had	on	a	mesh	was	depicted	in	a	color	

scale,	where	blue	indicates	no	influence	

and	red	indicates	maximum	influence.		

By	checking	the	weights	of	each	mode,	it	

could	be	confirmed	that	each	muscle	was	

only	being	influenced	only	by	the	bones	

intended	for	it.	As	seen	in	the figure 27 a 

bone	designed	to	influence	the	masseter	

should	have	no	influence	on	the	temporalis.		

The	temporalis	should	therefore	be	entirely	

blue	in	weight	paint	model.					

7.2 Animating a Gape cycle in Blender

	 To	date,	no	studies	have	been	published	on	the	chewing	biomechanics	of	Smilodectes gracilis 

specifically. The	chewing	mechanics	of	living	primates	in	general,	however,	have	fortunately	been	well	

documented.	In	order	to	simulate	a	believable	chewing	simulation	for	this	species,	a	chewing	gape	cycle	

depicting	Hiiemae’s	(1976)	four	gape-cycle	phases	were	simulated	based	on	data	for	a	“typical”	primate.		

A	gape	cycle	is	defined	as	“the	cyclical	elevation	or	depression	and	medial	or	lateral	movements	of	the	jaw	

defined	from	maximum	gape	to maximum	gape.	(Ross	and	Diaz,	2014	p.	106)”.	Hiiemae’s	four	gape-cycle	

phases	make	up	each	cycle	and	mark	the	key	jaw	kinematic	events	(Ross	and	Diaz,	2014).		 

These	phases	include:	

	 (1)	A Fast close (FC),	in	which	the	mandible	moves	upward	to	contact	the	food.

	 (2) A Slow close (SC),	in	which	the	mandible	slows	to	due	to	making	contact	with	the	food.

	 (3)	Slow open (SO),	in	which	the	tongue	is	adjusting	the	food.

	 (4)	Fast open (FO),	in	which	the	jaw	opens	quickly	to	begin	the	cycle	again.	

Figure 28. Screen shots in Blender in Weight Paint Mode showing 
a bone’s influence on the masseter muscle mesh.  Red indicates 

maximum influence: blue indicates no influence. 
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(Ross	and	Diaz,	2014,	Hiiemae	1976).	 Minimum gape occurs at the SC-SO transition and Maximum 

gape occurs at the FO-FC	transition.

	 In	order	to	simulate	a	gape	cycle	and	gape	phases,	figures	and	literature	were	used	as	visual	reference	

primarily	from	Ross	and	Diaz	review	“What	Does	Feeding	System	Morphology	Tell	Us	About	Feeding?”	

(2014)	and	Kay	and	Hiiemae’s	study	“Jaw	Movement	and	Tooth	Use	in	Recent	and	Fossil	Primates”	(1976).		

	 To	ensure	that	jaw	movement	was	as	accurate	as	possible,	the	muscles	were	not	attached	to	the	jaw	

during	animation	due	to	the	fact	that	they	block	visibility	of	the	temporomandibular	joint.		A	copy	of	the	

jaw	mesh	was	created	and	parented	to	the	same	skeleton	as	the	mesh	of	combined	muscles	and	jaw	.	When	

the	animation	was	complete	the	proxy	jaw	was	removed.		

7.2.1 Determining Maximum Gape 

	 Because	the	major	stages	of	a	gape	cycle	involve	a	minimum	and	maximum	gape	the	first	step	in	

simulating	a	chewing	cycle	was	to	determine	the	maximum	gape	of	the	virtual	Smilodectes	model.	

	 To	determine	the	maximum	gape,	the	jaw	was	rotated	using	the	Control Bone of the armature to 

rotate	it	around	the	transverse	axis.	When	the	condyle	of	the	jaw	“made	contact”	with	the	anterior	portion	

of	the	mandibular	fossa,	maximum	gape	was	considered	to	be	reached.		Because	the	objects	are	virtual	

and	cannot	actually	make	contact	with	one	another	“making	contact”	was	determined	to	be	just	before	the	

jaw	mesh	began	merging	with	the	edge	of	the	posterior	mandibular	fossa,	on	cranial	mesh,	while	in	“right 

orthographical view” in Blender.	(fig 29, 30)	This	is	similar	to	published	techniques	for	estimating	

maximum	gape	(Dumont	et	al.,	2011;	Fricano	and	Perry,	in	press).

		 When	a	primate	opens	its	jaw	to	a	maximum	gape	the	condyles	slide	rostrally	within	the	mandibular	

fossa.	(Ross	Diaz	2014)	The	further	the	condyle	is	displaced	rostrally	the	wider	the	gape	is.	As	it	is	

unknown	how	far	the	condyles	would	have	displaced	in	Smilodectes,	a	series	of	different	condyle	

displacement	figures	were	tested	to	document	a	range	of	gapes.	At	~2mm	the	condyle	of	the	jaw	mesh	

began	making	“contact”	with	the	cranial	mesh	(fig 29),	therefore	this	was	considered	the	maximum	

displacement.	The	was	measured	at	0mm,	1mm,	1.5	mm	and	2mm..	For	the	simulation	the	average	of	the	

four	gape	angles	was	used;	this	was	found	to	be	33.8o. (fig 31)  



36

Figure 29. Screens hots in Blender showing condyle displacement set at 2mm. 

Figure 30. Screens hots in Blender showing the condyle “contacting” the mandibular fossa (at 46.8o).
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Displacement	of	Condyles	

Along	X	axis	(millimeters)

Maximum	Gape

(Degrees	from	vertical	axis)

0mm -15o

1	mm -33.5o

1.5	mm -40.2o

2	mm -46.6o

Average: -33.8o

7.2.2 Choosing Key Frames

	 In	order	to	simulate	a	typical	primate	gape	cycle,	a	diagram	of	the	jaw	displacement	in	a	macaque	

was	used	as	reference	for	the	basic	pattern.	When	the	rostral	most	point	at	the	midline	of	the	jaw	is	

tracked	over	time	during	a	gape	cycle,	an	elliptical	shape	is	made	from	the	points’	vertical	and	horizontal	

displacement	(fig 32).		In	order	to	simulate	this	effect	in	an	animation,	specific	jaw	displacement	points	

were	chosen	along	the	elliptical	path	of	the	macaque	diagram	being	referenced,	and	recreated	in	Blender 

to use as a reference (fig 33).		The	displacement	of	the	jaw	mesh	at	those	points	was	then	key	framed.	

	 Eight	points	were	chosen	to	recreate	the	elliptical	pattern	in	the	Smilodectes	virtual	jaw.	Each	point	

represented	the	most	rostral	point	of	the	jaw	at	its	midline.	

One	point	was	chosen	to	account	for	the maximum	gape	(5)	and	another	for	the	minimum	gape	(1).		Two	

more	points	were	chosen	to	indicate	the	midpoints	between	minimum	and	maximum	gape	(one	when	the	

jaw	is	opening	(3)	and	one	for	jaw	closing	(7)).		Finally,	two	points	where	chosen	to	recreate	the	shape	

of	the	top	of	the	ellipse	(2,	8)	and	two	were	chosen	to	produce	the	shape	of	the	bottom	of	the	ellipse	(4,	

6).		Once	these	points	were	chosen	they	were	recreated	digitally	in	Blender by	adding	eight	cubes	in	the	

“front orthogonal view” in Blender,	and	moving	them	into	the	desired	elliptical	pattern	(fig 34).		The	jaw	

was	then	moved	to	match	these	points	and	its	position	would	be	key	framed.

Figure 31. Table showing the Maximum Gape in degrees from the vertical axis at different condyle 
displacement points.  The average Maximum Gape is also shown highlighted in yellow.



38

	 In	order	to	move	the	virtual	jaw	to	coordinate	with	these	reference	points,	the	jaw	needed	to	be	rotated	

about	the	transverse	axes	to	produce	jaw	depression	and	elevation,	and	rotation	about	the	vertical	axes	to	

produce	the	mediolateral	movements	of	the	teeth	and	anteroposterior	movements	of	the	condyles	(Ross	

and	Diaz	2014).

	 Jaw	depression	and	elevation	were	achieved	in	Blender	by	rotating	the	Control Bone	of	the	armature,	

along	the	X	plane	in	Blender under the setting XYZ Euler in the Transform section (fig 34).		In	order

to	achieve	the	mediolateral	movements	and	the	anteroposterior	movements	of	the	condyles,	the	Control 

Bone	of	the	armature	moved	along	the	Y	plane	in	Blender.		Once	the	jaw	was	in	position	the	Control 

Bone’s Location and Rotation Coordinates were	key	framed	at	that	point.

Figure 32. Image depicting the elliptical shape the path of the jaw’s vertical and horizontal path creates 
when the rostral most point at its midline is tracked during a gape cycle.  The eight points chosen to 

represent this shape are indicated in white circles. The X axis represents lateral displacement in mm and 
the Y axis represents vertical displacement in mm.

X

Y

-5mm

-5mm
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Figure 33. Screen shots in Blender showing the recreated elliptical shape made of cube objects  
and the jaw being matched to one of them.  

Figure 34. Screen shots in Blender showing (A) a close view of the jaw being moved to point 4 and (B) the Control Bone’s 
coordinates that were key framed. Location Z indicates the condylar displacement of 1.5 mm within the mandibular fossa, 

Rotation X indicated the jaw rotation around the transverse axis, and Rotation Y indicates the jaw rotation about the vertical axis. 
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Point 

number

Rotation around 

Transverse	Axis	

(Degrees)

Rotation around 

Vertical	Axis	

(Degrees)

Time	between	

points

(Number	of	Frames)

Phase	in	Gape	Cycle	

(FC,	SC,	SO,	or		FO)

1 -3o 0o 4 SO
2 -5o -2.2o 3 FO
3 -15o -3.6o 3 FO
4 -27o -	2.2o 3 FO
5 -30o 0o 2 FC

Figure 35. Screen shots in Blender showing the graph editor depicting the vertical displacement of the jaw (in degrees around the 
Transverse Axis). Colors and text are added over the screen shot to demonstrate how the graph is similar to actual data describing the 

four phases in the gape cycle (FC - Fast close, SC- Slow close, SO - Slow open, FO - Fast open) (Ross and Diaz 2014). 

Figure 36. Table describing the keyframe data at each point in the gape cycle. The table shows the Rotation around the Transverse 
Axis, Rotation around the Vertical Axis, Number of frames between each point, and the Phase in the Gape Cycle.
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7.2.3 Simulating Gape Phases

	 To	simulate	the	four	Gape	Phases	within	a	Gape	cycle	the	key	frames	within	each	cycle	were	given	

more	or	fewer	frames	depending	on	how	fast	the	action	was	supposed	to	be.		The	number	of	frames	given	

to	each	phase	is	listed	in	figure 36. The	graph	editor	was	used	to	confirm	that	the	shape	of	the	graph	

depicting	the	vertical	displacement	of	the	jaw,	was	similar	to	those	created	from	actual	data	(Ross	and	

Diaz	2014).	The	general	shape	of	the	displacement	matched	the	four	phases.	(fig 35)

	 When	playing	back	the	animation	a	realistic	chewing	cycle	is	achieved.		Each	of	the	four	phases	can	

be	identified	and	no	part	of	the	anatomy	is	intersecting	other	parts	of	anatomy	in	impossible	ways.

7.4 Shape keys and Volume Conservation 

	 When	an	armature	is	attached	to	the	vertices	of	a	mesh	model	the	vertices	will	move	with	the	

armature	when	it	is	posed.	Posing	the	armature	can	therefore	make	a	mesh	distort	and	move	in	a	variety	of	

ways,	ho;ever,	it	should	not	be	assumed	that	the	volume	of	the	mesh	is	conserved	as	it	is	manipulated.	As	

seen in figure 37		the	mesh	of	the	masseter	begins	with	a	volume	of	4.18cm3	before	the	armature	is	posed	

and	ends	with	a	volume	of	5.85	cm3	when	the	armature	is	posed.	The	volume	of	the	mesh	is	not	conserved	

during	its	transformation.

	 The	solution	for	conserving	the	meshes	volume	involves	the	use	of	Shape Keys	as	a	corrective	tool.		

A Shape Key	is	a	tool	that	stores	the	positions	of	a	mesh’s	vertices.		If	the	vertices	are	deformed	into	a	

new	position	a	shape	key	will	allow	a	mesh	to	be	returned	to	that	stored	position.	By	key	framing	Shape 

Keys	it	is	possible	to	animate	an	object	morphing	from	one	shape	to	another.	Shape Keys were used as 

a	corrective	tool	to	ensure	that	a	muscles’	mesh	maintained	its	volume	during	the	armature	animation	

through	series	of	steps:	
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Figure 37. Screen shots in Blender showing the volume being measured with the Volume Tool before  and after the armature displaces 
the mesh. The volume is shown to be (A) 4.18 cm3 before being displaced and (B) 5.8535 cm3 after being displaced. This demonstrates 

how volume is not conserved. Not all text is intended to be read.

A

B
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Shape keys	were	used	to	correct	muscle	volume	conservation	by	through	the	following	steps:

	 (1)	The	mesh	is	selected	and	while	in	Object Mode a Basis Shape Key was stored (Object Data >  

Shape Key > + ).	

	 (2)	Using	the	Volume tool (3D Print > Statistics > Volume),	the	volume	of	the	mesh	at	rest		

was	measured.		(Due	to	the	individual	muscle	meshes	being	combined	with	the	mandible		

	 and	lower	teeth mesh’s	the	volume	was	equal	to	the	sum	of	those	parts,	~	27	cm3 (fig 39)).

	 (3)	The	armature	was	selected	and,	while	in	Pose Mode,	was	posed	to	the	previously	determined		

	 position	of	maximum	gape	

	 (4)	The	mesh’s	volume	was	checked	again	using	the	same	process	as	step	1.	(It	was	noted	that	the		

	 mesh’s	volume	was	nearly	5cm3	greater	than	at	rest).		

	 	 (5)	A	second	Shape Key was created and named “Jaw Open”.		The	Relative Value	slide	bar	was		

 turned to 1.00.	Any	changes	made	to	the	mesh	would	now	be	stored	at	that	value.

	 (6)	The	Sculpt tools (in Sculpt mode)	were	used	to	correct	the	muscle’s	volume	by	“pushing”	the		

	 mesh	back	into	a	reasonable	shape	and	subsequently	checking	its	volume,	until	it	matched	the	original		

	 volume	measured	in	step	1	(fig 39). 

	 (7)	The	mesh	could	then	be	“morphed”	between	the	Basis Shape Key and the “Jaw Open”  

 Shape Key by	sliding	the	Relative Value slide	bar	between	the	values	of	0.000	and	1.000	(fig 38).

	 (8)	The	Relative Value	was	then	key	framed	to	coincide	with	the	movement	of	the	jaw	during	the		

	 animation	of	the	gape	cycle.		For	example,	when	the	jaw	was	at	full	occlusion	the	Relative Value  

	 was	key	framed	at	0.000	and	when	the	jaw	was	at	maximum	gape	the	Relative Value	was	key	framed		

	 at	1.000.		

Figure 38. Screen shot in Blender of Shape Key interface 
demonstrating the Relative Value slide bar being adjusted.
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Figure 39. Screen shots in Blender showing the volume being measured with the Volume Tool before  and after the armature displaces 
the mesh. The volume is shown to be (A) 30.8732 cm3 before being displaced and (B) 26.4637 cm3 after being displaced, which 

matches its original value at rest. Not all text is intended to be read.

A

B
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	 By	using	Shape Keys	to	correct	volume	conservation	and	the	Volume tool	to	verify	that	volume;	the	

animation	of	the	muscles	responding	to	the	jaw’s	movement	during	chewing	was	achieved	in	a	smooth,	

realistic,	and	accurate	way.	

7.5 Vertex Baking

 Blend4Web	does	not	currently	support	the	use	of	Shape Key animation controls and Armature 

animation	controls,	acting	on	the	same	mesh	

simultaneously.			The	workaround	to	using	these	

controls	while	preserving	the	ability	to	play	an	

animation in within a Blend4Web	interactive	

application,	is	to	Vertex Bake	the	animation	prior	

to	upload.			Vertex Baking is a tool that stores the 

positions	of	all	the	vertices	of	a	mesh,	within	a	

selected	range	of	key	frames.	Once	an	animation	is	

baked,	it	will	play	in	Blend4Web,	without	the	use	

the Armature and Shape Key controls that were 

used	to	create	it.

The Vertex Bake	tool	was	used	by	selecting	the	

“combined	jaw	and	muscle	object”	in	Object 

Mode	and	by	creating	a	new	Vertex Bake 

Animation (Blend4Web tab > Bake Vertex 

Animation > name “Chew_ SMILO” > Bake).		

One	complete	cycle,	including	the	four	phases	 of 

the	gape	cycle,	was	chosen	to	Bake.		The	duration	was	set	by	inputting	the	frame	range	of	the	cycle	into	

the Start and End	fields	within	the	Vertex Bake	settings.	The	settings	used	for	the	Vertex Bake of the 

chewing animation are shown in fig 40. 

Figure 40. Screen shot in Blender showing Bake Vertex 
Animation settings.
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8. Creating interactive applications using Blend4Web

 Blend4Web,	a	WebGL	framework	and	a	3D	content	creation	suite	based	on	the	3D	engine	Blender 

was	used	in	this	project	to	create	interactive	application	to	display	the	virtual	models	created	and	to	share	

them	online.		This	project	created	interactive	applications	for	the	virtual	reconstructed	skull	and	chewing	

musculature of Smilodectes gracilis	as	well	as	the	chewing	simulation.		It	created	a	separate	interactive	

for	the	facial	approximation	model.			The	environment,	lighting,	and	camera	set	up	was	the	same	for	both	

interactive	applications.

8.1 Creating an Environment

	 A	background,	and	lighting,	and	a	camera	were	added	to	the	scene	to	set	the	models’	environment.	

The	background	was	created	by	adding	a	flat	plane	(Add > Mesh > Plane) to the scene and modeling it 

into	a	curved	plane	that	served	as	the	floor	and	backdrop	of	the	scene.		The	color	of	the	plane	was	set	to	

white (Properties > Material > Diffuse).

	 To	light	the	scene,	one	Sun light and four Point lights	were	placed	in	the	scene.		A	Sun light 

propagates	from	an	infinite	plane	in	one	direction	without	attenuation	(Yao,	2017).		This	light	was	used	to	

light	the	entire	scene.	Point lights	propagate	from	one	source	to	all	directions	with	gradual	attenuation.		

These	lights	were	used	as	fill	lights	and	to	create	highlights	on	the	model.			The	Sun light	was	the	only	

light	that	was	allowed	to	produce	shadows.	Shadows	were	enabled	in	the	light	properties	(Properties > 

Object Data > Shadows).	The	model	was	also	set	to	cast	shadows	(Properties > Object > Shadows > 

Cast Shadows).	The	view	of	the	scene	was	set	by	adding	a	Camera (Add > Camera).		The	camera	was	

moved	to	a	location	that	framed	the	model	in	an	aesthetic	way.

	 To	create	interactive	buttons,	Planes were	added	to	the	scene,	modeled	into	the	desired	shape,	and	

given	a	color.		Text	is	treated	the	same	as	any	other	mesh	in	Blender.		Each	word	was	added	as	a	separate	

object	and	moved	to	the	desired	location	in	the	scene.	One	“on	button”	and	one	“off	button”	were	created	

for	each	of	the	muscles	as	well	as	for	the	chewing	animation.	

		 In	order	to	keep	the	background,	lights,	buttons,	and	text	static	within	the	scene,	they	were	parented	

to the Camera (Object > Parent).	By	doing	this,	the	model	becomes	the	only	object	that	can	moved	in	the	

scene.	
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The	movement	of	the	model	itself	was	also	restricted	using	the	Camera Limits	parameters	in	the	

Camera properties tab.		The	Camera Limits	used	in	the	interactive	application	for	this	project	are	

show in figure 41.

8.2 Creating a Node Tree

	 To	create	interactivity,	the	Node Editor	was	used.		To	activate	logic	on	the	scene	the	Logic Editor 

property	under	the	Scene tab was selected and an Active Node Tree	was	appended.		The Logic Tree 

was	edited	by	selecting	the	Blend4Web Logic Tree	type	and	selecting	the	appropriate	node	tree.	

	 Nodes	are	logic	blocks	which	are	executed	from	an	Entry Point	node	which	has	no	inputs	and	

only	one	output.	All	the	other	nodes	have	both	inputs	and	outputs	which	are	used	to	by	inserted	

anywhere	in	the	tree.	The	Select, Hide Object and Show Object Nodes were used to create a node 

tree	that	allows	the	interactive	functionality	of	turning	on	and	off	the	individual	muscles	on	the	model,	

when	a	corresponding	button	is	clicked.	The	Select node	was	used	to	trace	the	selection	of	any	object	

from	the	object	list.	The	Hide Object Node hides	an	object	if	its	condition	is	met,	and	the	Show 

Object Node	shows	an	object	if	the	condition	is	met	(fig 42).	To	play	the	chewing	simulation	the	Play 

Animation node was used (fig 42).	The	full	node	tree	can	be	seen	in	figure 43.

Figure 41. Screen shot in Blender 
showing the Camera Limit’s settings used.
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Figure 42. Screen shot in Blender showing the Select Node used in creating the Node Tree, including (A) 
the hide object node, (B) the Switch Select node, and (C) the play animation node.

A

B

C
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Figure 43. Screen shot in Blender showing the Node Tree used for the interactive application.  
Text is intended to be read.
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8.3 Annotations

Labels	and	annotations	are	valuable	tools	for	the	

biocommunicator	and	scientist.		Blend4Web 

offers	a	useful	built	in	annotation	system.	The	

annotation	tags	are	2D	HTML	elements,	which	

follows	particular	positions	of	the	3D	model.		

Positions	were	created	for	the	2D	annotation	

element	to	track	by	creating	an	Empty Plane 

Axes	and	moving	them	to	the	position	where	an	

annotation	was	desired.	The	Anchor was then 

enabled	in	the	Object panel (Properties > Object 

> Enable Anchor).		These	Anchors also contain 

an	interactive	property	which	permits	additional	

content	to	be	added	that	drops	down	within	the	

anchor	when	the	anchor	is	clicked.	The	additional	

content	could	include	text	or	an	image	and	is	added	in	the	Object properties	tab (Properties > Object 

> Meta Tags > Description) (See fig 44)		This	project	utilized	the	Anchors to create annotations that 

labeled	each	muscle	and	when	clicked	provided	more	information	about	that	muscle.

8.4 Exporting

The	interactive	web	application	was	launched	by	exporting	its	HTML	file	and	loading	it	onto	a	personal	

server	as	a	test.		The	application	ran	smoothly	and	all	interactive	elements	worked	as	designed.		

Figure 44.  Screen shot in Blender showing 
Annotation properties used for the Masseter 

annotation
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results 
1. Fossil Reconstruction Results

The	reconstruction	of	the	fossil	specimen	of	Smilodectes gracilis	had	three	stages	each	which	yielded	

results	useful	in	improving	the	study	of	the	species	and	more	specifically	the	study	of	the	species’	chewing	

architecture.		The	first	stage	resulted	in	a	virtual,	segmented	fossil	freed	of	much	of	the	sediment	it	was	

impacted	by	and	reoriented	in	an	anatomically	correct	position.		The	second	stage resulted	in	a	virtual,	

restored	fossil	whose	distortions	and	fragmentations	were	corrected	and	missing	anatomy	accounted	for.		

The	third	stage	resulted	in	a	virtual,	fully	reconstructed,	model	of	the	specimen	with	realistic	texture	and	

detail	added.	These	stages	are	shown	in	the	following	labeled	diagrams:
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Figure 45.  Lateral view
 of original virtual fossil. 

Figure 45.
 Lateral view

 of original virtual fossil. 
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Figure 46.  Lateral view
 of the virtually restored cranium

 and m
andible.

Figure 46.
 Lateral view

 of the virtually restored cranium
 and m

andible.
 Lateral view

 of the virtually restored cranium
 and m

andible.
 Lateral view

 of the virtually restor
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Figure 47.  Lateral view
 of the virtual reconstruction of the skull.

Figure 47.
 Lateral view

 of the virtual reconstruction of the skull.
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Figure 48.  Posterior view
 of the virtual reconstruction of the skull.

Figure 48.
 Posterior view

 of the virtual reconstruction of the skull.
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2. Muscle Reconstruction Results

The	jaw	adductor	muscles	of	Smilodectes gracilis	were	reconstructed	both	numerically	and	virtually.		

Dimensional	data	was	calculated	from	osteological	measurements	taken	from	the	virtually	restored	fossil	

specimen.		Volumetric	estimate	of	the	sizes	of	the	masseter,	medial	pterygoid	and	temporalis	muscles	were	

found. The	dimensional	data	was	then	used	to	create	virtual	models	that	could	attach	to	the	virtual	skull	

and	mandible	model	previously	created.	

2.1 Dimensional Data

2.2 Virtual Jaw Adductor Models

The	volumetric	estimates	of	the	jaw	adductor	muscles	were	used	to	digitally	recreate	virtual	muscle	

models	which	are	presented	in	the	following	labeled	diagrams	(fig	49,	50).

2.3 Origin and Insertions sites 

The	muscles	were	recreated	based	on	their	origin	and	insertion	sites.		Diagrammatic	interpretations	of	

these	sites	were	created	on	the	skull	and	mandible.	(fig	51)

Figure 49.  Table of volume estimates of the jaw adductor muscles.
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Figure 50.  Lateral view
 of the virtual m

uscle reconstruction.  
Figure 50.

 Lateral view
 of the virtual m

uscle reconstruction.  
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Figure 51.  Lateral view
 of the virtual m

uscle reconstruction w
ith M

asseter rem
oved.  

Figure 51.
 Lateral view

 of the virtual m
uscle reconstruction w

ith M
asseter r



59

Figure 52. Posterior view
 of the virtual m

uscle reconstruction w
ith M

asseter rem
oved.  

Figure 52.
Posterior view

 of the virtual m
uscle reconstruction w

ith M
asseter r
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Figure 53.  Medial and Lateral views of the origin and insertion sites of the jaw adductor muscles.
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3. Chewing biomechanics Results

Figure 54.  Still screen captures of the dynamic chewing simulation.

3. Chewing biomechanics Results
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4. Facial Approximation Results 

A	virtual	3D	facial	approximation	sculpture	was	created.	The	stages	are	documented.	Underling	skeletal	

and	muscular	anatomy	were	used	from	the	previous	models.	

Figure 55.  Virtual facial approximation. 

4. Facial Approximation Results 

A virtual 3D facial approximation sculpture was created. The stages are documented. Underling

and muscular anatomy were used fromfromf the previous models.
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5. 3D Interactivity Results 

A	fully	interactive	application	was	created	featuring	the	chewing	simulation	and	muscle information.		

Figure 56.  Screen shots displaying the interactive chew
ing sim

ulation in a w
eb application

Figure 56.
 Screen shots displaying the interactive chew

ing sim
ulation in a w

eb application
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Figure 57.  Screen shot displaying the interactive w
eb application, displaying m

uscle interactivity.
Figure 57.

 Screen shot displaying the interactive w
eb application, displaying m

uscle interactivity
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Figure 58.  Screen shot displaying interactive w
eb application, displaying m

uscle interactivity.
Figure 58.

 Screen shot displaying interactive w
eb application, displaying m

uscle interactivity
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6. Work Flow Results 

Documentation	of	the	workflow	is	presented	in	stages	divided	by	software.	

Figure 59. Diagram of the  project work flow.
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7. Asset Referral Information

Assets	can	be	found	at	

amandasladeillustration.com	and	

The	Department	of	Art	as	Applied	to	Medicine

Johns	Hopkins	University	

Baltimore,	MD
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DISCUSSION
	 The	goal	of	this	project	as	a	whole	was	to	create	a	comprehensive	virtual	reconstruction	of	an	early	

primate’s	chewing	anatomy	and	biomechanics	in	order	to	enhance	the	value	of	the	fossilized	cranium	

and	mandibles	of	Smilodectes gracilis	as	objects	of	study.		This	section	reviews	and	discusses	what	was	

involved	in	creating	the	models,	animations,	and	interactive	applications	created	to	achieve	the	primary	

goal	as	well	as	any	drawbacks	or	limitations	that	were	encountered	at	each	stage.	

1. Fossil Reconstruction 

	 The	primary	goal	of	the	reconstruction	of	the	Smilodectes gracilis	specimen,	was	to	provide	a	virtual	

model	of	the	specimen,	free	of	the	damage	and	distortion	that	typically	encumbers	a	scientist	in	making	

accurate	osteological	measurements.		The	Smilodectes fossil	being	studied	in	this	project	for	example,	was	

so	impacted	by	sediment	that	certain	osteological	landmarks,	such	as	the	attachment	area	of	the	medial	

pterygoid,	were	entirely	obscured.		The	virtual	reconstruction	of	the	specimen	that	was	produced	was	

unencumbered	by	these	flaws	was	able	to	yield	the	osteolgical	dimensions	need	for	muscle	reconstruction.	

	 When	reconstructing	a	damaged	specimen	there	is	the	inherent	risk	of	bias	entering	the	decision	

making	of	the	changes	to	make.	A	fully	reconstructed	model	might	sacrifice	accuracy	for	completeness.		

In	the	Smilodectes fossil specimen	used	for	this	project,	for	instance,	a	significant	portion	of	the	nasal	

region,	as	well	as	parts	of	the	zygomatic	arch	were	missing	from	the	fossil	and	required	reconstruction	

based	entirely	on	reference	material	rather	than	content	from	the	specimen	itself.	The	ambiguity	of	such	

reconstruction	techniques	was	in	some	part	resolved	by	utilizing	a	three	stage	approach	that	emphasizes	

transparency	to	the	changes	being	made.	The	reconstruction	moved	through	the	stages	of	first,	a	

segmented	model;	second,	a	restored	model;	and	finally,	a	fully	reconstructed	model.		The	techniques	

and	software	used	are	described	in	the	Materials and Methods	section.	This	three	stage	approach	

allows	for	any	changes	made	or	anatomy	added	to	be	entirely	clear	to	the	viewer.		A	scientist	interested	

in	this	species	or	early	primates	in	general	has	full	access	to	virtually	analyzing	the	anatomy	of	a	nearly	

unaltered	fossil	of	the	species	or	a	fully	reconstructed	approximation	of	the	bony	morphology	without	risk	

of	mistaking	reconstructed	data	for	raw	data.

2. Muscle reconstruction:

 Reconstructing the chewing musculature for Smilodectes gracilis	was	achieved	both	numerically	and	

virtually.		The	numerical	dimensional	data	for	muscle	size	calculated	for	this	study	generally	suggest	that	
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the	jaw	adductor	muscles	of	this	species	were	large,	although	further	analysis	is	needed.	

	 Some	literature	suggests	that	large	muscle	mass	indicates	a	folivorous	diet	(Taylor	and	Vinyard	

2009).	Perry’s	study	(2015)	states	that	if	the	estimates	for	PCSA	(physiological	cross	sectional	area)	for	

Adapis	and	Leptadapis	,“	are	large,	then	this	would	provide	support	for	a	folivorous	diet	(Perry,	2015,	p.	

3)”.	Smilodectes,	Adapis and Leptadapis	are	all	adapiform	primates	and	it	is	reasonable	to	assume	a	large	

PCSA in Smilodectes	would	also	provide	support	for	the	species	having	a	folivorous	diet.		This	would	in	

turn,	support	the	dental	analysis	that	Smilodectes	was	a	foliovore	(Rose,	1974).		There	is	also	literature	

that	suggests	that	“Truly	massive	jaw	adductors	are	expected	if	a	primate	must	ingest	large	objects	that	

are	also	very	resistant	to	breakage	because	these	animals	simultaneously	require	long	fibers	and	forceful	

adductors	with	great	PCSA	(Taylor	and	Vinyard,	2009,	Perry	2015)”	If	the	jaw	adductors	on	this	specimen	

of Smilodectes gracilis were	deemed	as	truly	“massive”	then	further	inferences	might	be	made	about	its	

diet	including	large,	resistant	objects.		The	data,	however,	would	need	to	be	analyzed	further	before	it	

could	be	presented	as	solid	support	for	a	particular	diet.	

	 The	virtual	3D	reconstructions	of	the	jaw	adductors	were	able	to	provide	a	visual	verification	that	

the	numerical	dimensional	data	were	realistic.		When	the	reconstructed	musculature	was	attached	to	the	

virtual	skull	reconstruction,	the	volumetric	relationship	between	muscle	and	skull	were	not	obviously	

disproportionate.	That	is,	they	more	or	less	resembled	cadavers	of	primates	in	the	muscle-to-bone	size	

relationship.	In	addition,	there	were	no	osteological	constraints	that	made	the	reconstructions	impossible.		

The	muscle	reconstruction	generally	fit	the	skull	in	a	believable	way.		This	was	confirmed	by	Dr.	Perry	

at	the	Department	of	Functional	Anatomy	and	Evolution	and	generally	conforms	to	anatomical	evidence	

from	strepsirrhine	primate	dissection	photographs	(Perry,	2008).

The	combination	of	numerical	dimensional	reconstruction	and	virtual	3D	reconstruction	provides	a	

clearer	picture	of	the	jaw	adductors	for	Smilodectes	gracilis	than	has	ever	been	provided	before.	The	data	

collected	have	the	potential	to	inform	inferences	on	the	diet	and	perhaps	support	the	dental	analysis	that	

the	species	was	a	foliovore.		

3. Chewing model and Animation

	 The	primary	purpose	of	creating	a	chewing	model	of	an	extinct	primate	was	to	virtually	demonstrate	

the	digital	jaw	adductor	models	in	action	and	thus	provide	visual	validation	that	the	muscle	volume	

predictions	were	reasonable.		This	was	achieved	in	that	the	musculature	when	put	to	motion	did	not	behave	

in	a	way	that	would	invalidate	or	put	into	question	the	volumetric	estimates.		This	was	confirmed	by	Dr.	

Perry	as	well.
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	 The	secondary	goal	of	this	endeavor	was	to	create	a	fully	articulated	and	rigged,	digital	model	that	

would	allow	parameters	such	as	joint	constraints	or	jaw	angle	to	be	input,	and	then	cause	the	chewing	

musculature	to	respond.	Such	a	model	demonstrates	a	unique	option	for	studying	chewing	biomechanics.	

The	model	successfully	used	numerical	inputs,	a	virtual	simulation	of	movement.		The	inputs	used	for	this	

simulation	were	approximations	of	the	chewing	cycle	of	primates	supplied	by	published	literature	(Ross	

and	Diaz,	2014,	Kay	and	Hiiemae,	1974).	The	parameters	that	allow	numerical	input	include:	rotation	of	

the	jaw,	displacement	within	the	temporomandibular	joint,	and	time.

	 Although	hard	data	were	not	produced	from	the	model,	it	set	the	stage	for	future	studies	in	

jaw	biomechanics.	The	success	of	the	simulation	also	validates	the	time	and	effort	spent	virtually	

reconstructing	and	rigging	the	models.

4. Facial approximation

	 This	project	lent	itself	to	an	artistic	reconstruction	of	the	face	of	Smilodectes  as the animal might 

have	appeared	in	life.	With	so	much	of	the	facial	anatomy	reconstructed	in	previous	stages	of	the	project,	

much	of	the	science	based	work	in	facial	approximation	had	been	completed.		The	result	is	a	virtual	model	

of	a	realistic	animal	that	brings	an	extra	layer	of	imagination	and	inspiration	to	the	project.	

	 The	added	benefit	of	this	facial	approximation	being	a	virtual	3D	model	allows	it	to	be	used	in	

a	variety	of	ways.		It	can	be	posed	and	lit	in	within	all	artistic	3D	software	to	create	2D	still	images	

or	animations.	It	can	also	be	loaded	onto	any	online	3D	viewing	platform	such	as	Blend4Web which 

dramatically	increases	its	accessibility.		

	 Paleoart	has	always	been	a	driver	of	the	public’s	interest	in	the	field	of	paleontology,	and	it	could	be	

argued	to	be	a	driver	of	its	funding	as	well.	This	final	layer	added	to	the	reconstruction	of	Smilodectes 

gracilis	has	the	potential	to	inspire	further	studies	of	early	primates.	

	 A	secondary	result	is	a	documented	process	of	how	the	facial	approximation	was	achieved.		The	

relationship	between	scientist	and	artist	when	creating	paleoart	has	little	reproducible	documentation.		The	

technique	is	largely	dependent	on	the	artist’s	and/or	scientist’s	personal	aesthetics	and	preference.		This	

project	documents	the	scientific	foundation	upon	which	the	approximation	was	based	and	makes	clear	

the	degree	to	which	the	approximation	was	based	on	scientific	data	and	the	degree	to	which	it	was	left	to	

artistic	interpretation.	
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5. Web application and Interactively

	 All	models	and	animations	created	in	this	project:	the	three	stages	of	fossil	reconstruction,	muscle	

anatomy,	chewing	simulation,	and	facial	approximation	were	made	into	interactive	HTML	web	

applications.		An	interactive	option	for	the	project	was	chosen	to	increase	accessibility.		The	application	

allows	for	anyone	with	an	internet	connection	to	access	the	models	.		The	models	can	be	rotated	

and	enlarged,	allowing	scientists	to	appreciate	the	three	dimensionality	inherent	to	fossils	and	fossil	

reconstruction.	

	 The	interactive	applications	created	are	self-contained	HTML	websites	that	do	not	considerably	

request	data	from	the	server.	The	performance	relies	entirely	on	the	local	GPU	and	CPU	upon	loading	(Li,	

2017).		Several	parameters	can	be	taken	into	account	in	order	to	optimize	the	performance	for	WebGL.		

Polygon	count,	light	sources,	shadows,	and	ambient	occlusion	can	affect	the	performance.		To	optimize	

performance,	environmental	objects	were	kept	at	a	very	low	poly	count;	only	the	model	was	allowed	a	

shadow	and	ambient	occlusion	was	disabled.	The	models’	meshes	themselves	were	optimized	as	described	

in the Materials and Methods	section.	During	testing	the	application	loaded	and	ran	well	on	a	2016	iMac	

(Processor	3.3	GHz	Intel	Core	i5;	Graphics:	AMD	Radeon	R9	M395X	4096	MB).		

6. WebGL using Blend4Web

	 WebGL	is	a	recent	technology	having	been	released	in	only	2011	and	whose	second	iteration	was	last	

year	(January	2017).	WebGL	frameworks	and	libraries	have	been	developed	since	in	order	to	utilize	the	

technology	for	interactive	web	application	development	(Li,	2017;	“List	of	WebGL	frameworks”,	2016).		

3D	game	engines,	for	example,	have	been	starting	to	incorporate	engine	based	WebGL	frameworks	such	

as Unity and Blender.		This	is	especially	useful	for	the	people	interested	in	using	the	technology	but	

who	have	no	background	in	coding,	as	opposed	to	the	popular	open-source	framework	three.js.	These	

frameworks	also	have	the	advantage	of	well	developed	user	interfaces	that	are	familiar	to	3D	artists.

Although	Unity	is	a	well-used	3D	game	engine	its	WebGL	capabilities	have	not	yet	been	well-developed	

(Bezuhoff,	2015).		Blende4web	however,	is	unique	in	that	it	was	developed	as	a	new	“mode”	within	

Blender	that	allows	artists	to	build	3D	scenes	and	export	them	directly	to	WebGL.	It	also	features	a	

logic	node	editor	and	interactive	functions	that	can	be	embedded	on	objects	without	coding	(Li,	2015).	A	

drawback	is	that	2D	elements	within	the	web	application	are	better	created	with	coding	using	JavaScript.		

This	script,	however,	is	arguably	much	easier	to	learn	than	others	such	as	C++	or	C#.		As	such,	less	

complex	projects	that	do	not	rely	heavily	on	2D	assets	can	still	be	created	without	any	coding,	as	this	

project	was.		
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Blend4Web	is	an	add-on	of	Blender	and	therefore	shares	the	same	interface;	however,	its	functionalities	

are	different	when	operating	in	Blend4Web.		Blend4web	is	completely	based	on	JavaScript	for	browser-

based	real-time	rendering	and	uses	its	own	render	engine	as	opposed	to	the	default	render	engines	within	

Blender (Blender Render and Cycles Render).		The	primary	differences	that	this	project	encountered	

were	the	differences	in	animation	capabilities.		This	project	required	animation	to	take	place	on	multiple	

objects	each	of	which	utilized	armature	animation	and	Shapekey animation. Blend4web	does	not	support	

simultaneous	use	of	these	animation	functions.		The	workaround	required	the	vertex baking option	

described	in	the	Materials and Methods	section.	While	vertex baking	was	a	success,	it	did	require	the	

model	to	be	processed	in	a	different	way.	

	 An	additional	animation	challenge	that	was	encountered	was	the	need	for	multiple	objects	to	be	

animated	simultaneously.		Although	the	playback	of	these	could	be	programed	to	play	at	the	same	time	

with	the	node	editor,	the	results	were	not	reliable	and	objects	would	become	out	of	sync	(masseter	muscle	

would	flex	at	a	different	rate	than	jaw	movement,	for	example).		The	solution	required	combining	all	

objects	and	animating	them	as	a	single	object;	this	process	is	described	in	the	Materials and Methods 

section.	The	solution	was	successful;	however,	it	sacrificed	control	over	individual	aspects	of	the	

animation.		While	researching	solutions	to	the	animation	problems	encountered,	it	became	clear	that	the	

Blend4Web	team	is	prioritizing	advancing	the	animation	capabilities	for	future	Blend4Web	versions,	as	

many	users	were	encountering	similar	issues.	

7. Working in Blender

 Blender	is	a	free	3D	open	source	software.	Any	techniques	documented	in	this	project	are	therefore	

accessible	without	budget	being	a	limiting	factor.	Because	of	its	accessibility,	a	significant	community	

that	uses	it	and	presents	tutorials	and	techniques	which	were	used	in	this	project.		The	large	and	diverse	

population	of	Blender	have	also	created	a	range	of	add-ons,	many	of	which	are	also	for	free.		This	project	

utilized	the	3D	printer	add-on	and	the	Blend4Web	add-on.	These	add-ons	aided	workflow	in	that	the	

different	stages	of	the	project	did	not	require	separate	software	for	their	completion.		Measuring	the	

volume	of	the	muscle	models	for	instance,	could	be	completed	within	Blender	using	the	3D	printing	add-

on	rather	then	needing	to	be	exported	to	a	separate	3D	printing	software.	

8. Working in Z Brush 

	 This	program	has	maintained	its	place	as	the	best	sculpting	software	for	years	and	this	project	
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could	do	nothing	but	confirm	its	standing.		This	program	was	instrumental	in	the	success	of	creating	

realistic,	detailed,	and	aesthetic	reconstructions.	Its	mesh	optimizing	capabilities	were	also	important	for	

creating	low	poly	models	that	could	easily	be	unwrapped	during	the	UV	unwrapping	process,	described	

in	the	materials	and	methods	section.	By	being	able	to	process	and	sculpt	up	to	a	billion	polygons,	

it	also	permitted	the	reconstruction	of	the	fractured	skull.		Finally,	during	the	creation	of	the	facial	

approximation,	the	tools	in	Z brush	allowed	for	realistic	and	aesthetic	rendering	to	be	created.	

9. Reproducible Workflow 

	 The	workflow	created	in	this	project	covers	three	different	programs	and	utilizes	a	variety	of	tools	

within	each.	The	workflow	is	streamlined	in	that	the	movement	through	each	of	the	programs	is	linear.	

Each	stage	is	contained	within	a	specific	software.		The	workflows	within	each	software	are	also	useful	

in	isolation.	For	instance,	the	Z Brush stage	could	be	skipped	and	a	fossil	could	be	brought	directly	into	

Blender	for	processing	and	uploading	onto	the	internet.	This	workflow	offers	a	road	map	for	not	only	

biocommunicators,	but	those	interested	in	virtual	paleontology	which	is	quickly	taking	over	the	field.

CONCLUSION

	 This	project	gave	rise	to	the	first	dynamic	fully	articulated,	manipulable,	animated	and	interactive	

model	of	an	extinct	primate’s	masticatory	apparatus,	featuring	a	reconstructed	fossil	skull,	jaw	adductor	

musculature	and	facial	approximation.	A	full	range	of	digital	processing	software	was	utilized	and	

information	across	disciplines	was	integrated.	The	models	incorporate	data	from	comparative	anatomy,	

functional	morphology,	and	biomechanics.	The	project	utilized	the	full	range	of	digital	processing	

to	complete	the	project	including	CT	imaging,	3D	sculpting,	rigging,	animation,	and	finally	online	

interactive	software.	This	project	not	only	pushed	the	boundaries	of	the	study	of	early	primate	chewing	

architecture	and	dynamics	but	also	documented	a	novel	workflow	that	demonstrates	a	future	direction	of	

paleontological	imaging	and	represents	the	full	power	of	combing	art	and	science.
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